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INTRODUCTION

INTRODUCTION

This document describes the job management features of the Splash RPX-iii Xerox 700
Digital Color Press for Apple Mac OS and Microsoft Windows computers. The

Splash RPX-iii Xerox 700 Digital Color Press is a high-end Color Publishing Print Solution
for use on Intel Mac or G5 Mac platforms. Splash user software enables Mac OS or Windows
computers to send print jobs across an appropriate network to the Splash RPX-iii Xerox 700
Digital Color Press, which processes the jobs and sends them to the digital press. If you are
unfamiliar with your platform’s procedures for printing or integrating printers within the
network environment (Windows 2000/XP/Server 2003/Vista, AppleTalk, UNIX, Novell, and
Microsoft TCP/IP), see the documentation that accompanies your computer system.

Terminology and conventions

This document uses the following terminology and conventions.

Term or convention Refers to

Digital press Xerox 700 Digital Color Press

Fiery Xerox EX Print Server and Integrated Fiery Color Server

Mac OS Mac OS X

EFI Splash RPX-iii Splash RPX-iii Xerox 700 Digital Color Press

Tiles in izalics Other documents in this set

Windows Windows 2000, Windows XP, Windows Server 2003, Windows
Vista

About this document

This document describes the EFI Splash RPX-iii server interface, functions, and job
management options. The following topics are covered:

* EFI Splash RPX-iii user interface

* Advanced features of EFI Splash RPX-iii

e Production features of EFI Splash RPX-iii

 Splash Server Remote 3

* Drop Folders, Hot Folders, Virtual Printers, and the GA File Converter
*  Web Queue Manager
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USING THE EFI SPLASH RPX-iii

This chapter provides an introduction to the EFI Splash RPX-iii graphical user interface and
its basic functions.

Starting the EFI Splash RPX-iii

In order for you to use the EFI Splash RPX-iii, it must be connected to a Xerox EX Print
Server using Direct Connect or Network Connect. With Direct Connect, the EFI

Splash RPX-iii automatically connects to the Fiery. With Network Connect, the connection
to the Fiery must be configured. Consult your network administrator for the Fiery IP address.

For more information about setup for Direct Connect and Network Connect, see Getting

Started.

To CONNECT TO THE FIERY USING NETWORK CONNECT

1 Click the Splash Server icon in the Dock on the Macintosh desktop, or double-click the Splash
Server icon in the /Applications/Splash RPX-iii Xerox 700 Digital Color Press Folder.

NoTe: The Dock appears when you roll your mouse to the bottom of the screen.

Splash RPX-iii

Welcome! Before you begin using your Splash server, you need to
indicate how it is connected to your Fiery controller,

1 Direct Connect
M The Fiery is connected directly to your
Macintosh by an Ethernet crossover cable. The

Splash has exclusive access to the Fiery.

i Network Connect
‘ Both the Fiery and Splash are connected to your
J local network. The Fiery will still be visible to all

clients.
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2 Click Network Connect.

Choose the IP address of the controller to which the Splash Server
should connect:

Name IP Address

10.11.96.91

Reload
Manually enter an address:
10.11.96.91
()

3 If the Fiery that you want to connect to is listed in the Controller Connection window, select
the name and IP address in the list and click OK.

4 If the Fiery that you want is not listed, type the IP address in the “Manually enter an
address” text field, and then click OK.

A message appears notifying you when you have successfully connected to a Fiery.

5 Click OK to display the EFI Splash RPX-iii main window.
If you selected Network Connect in error, click Direct to set up Direct Connect.

The following procedure describes setting up Direct Connect when you start the EFI
Splash RPX-iii for the first time.
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TO CONNECT TO THE FIERY USING DIRECT CONNECT

1 Click the Splash Server icon in the Dock at the bottom of the EFI Splash RPX-iii Macintosh
desktop, or double-click the Splash Server icon in the Applications:Splash Folder.

NoTe: The Dock appears when you roll your mouse to the bottom of the screen.

Splash RPX-iii

Welcome! Before you begin using your Splash server, you need ta
indicate how it is connected to your Fiery controller.

[ Direct Connect
M The Fiery is connected directly to your
Macintosh by an Ethernet crossover cable. The

Splash has exclusive access 1o the Fiery.

[ Network Connect
| Both the Fiery and Splash are connected to your
local netwaork. The Fiery will still be visible to all

f————  dients.

2 C(lick Direct Connect.

NoTe: You must connect the Splash RPX-ii Macintosh directly to the Fiery using an Ethernet
crossover cable. Follow the instructions in Getting Started.

If the connection is successful, a message is displayed. Your Splash Server is now connected
directly to the Fiery.

To quit the EFT Splash RPX-iii application, return to the main window and press
Command+Q), or choose Quit Splash Server from the Splash Server menu.
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The EFI Splash RPX-iii interface

After you start the EFI Splash RPX-iii application and connect to a Fiery, the main window
appears. The main window displays information about managing print queues, administering
server functions, and controlling the jobs in the print queues.

1 EFI Splash RPX-iii toolbar
2 Start/Stop button
3 Active queue

4 Hold queue

3 ) Active \  Preview \
Status Document User Copies Pages  Spool Tim B
5 Error queue | Pending Splash RPX-iii Startup Page.pdf Drap Folder 1 1 4/21/08
pending Splash RPX-iil Startup Page.pdf Drop Folder 1 1 4/21/08 1\
6 Preview window Pending IDFinstall.pdf Dropped File 1 46 3/13/082 4
| Pending Gerting Started splashserver 1 17 3/14/08 3
1 C 4>
7 Trays
8 Device status
= —g
9 Splash Server status
o~ AN S
10 Cover Flow control @ \
DP700
11 Cover Flow window 1— Letter LEF 3 — Tabloid
L ! = |~
. 2 — A4 LEF
12 Text Filter ==
Info Document User Size Pages  Spool Time Comple b |
SR Scanner Target.ps admin 191 KB 1 3/19/0812:47 PM_ 4/14/0 Online
SR Splash RPX-iii Startup Page.pdf Drap Folder 1.6 MB 1 3/14/08 3:58PM  4/14/0
3 CopyCal Target.ps admin 191 KB 1 3/25/08 5:50PM  4/14/0
ya »
£ Splash
5 Error \
g . Controller: DC-700-4ABC50 (10.16.225.108)
|Document User Completion Time  Error Message Applaralkerkin (SpleREERE
Splash RPX-iii Startup Page.pdf Drop Folder  3/26/08 12:24 PM Mo Uncoated (81-90 gsm) paper in selecti— IP Printing: Online (10.10.83.24)
Splash RPX-iil Startup Page. pdf Drop Folder  3/26/08 1219 PM No Uncoated (81-50 gsm) paper in select) Last Calibrated: Not Calibrated
Center A\!gnmem Ver!ﬁm(!un Page.pdf Drop Folder 3/19/08 6:03 PM electi Disk Space Used Free
— L Mams mAE Menn Ealdne 301000 £.03 oA D —— it
7

000

Splash Server

5 ¢« u

o &
1 QJ 1A ;
ColorCal CopyCal Profile Loader ColorTuner Coler Tweak SetBuilder Scan

@ @ @ Splash RPX-iii
7 Start/Stop Stopped

The following sections describe each component of the EFI Splash RPX-iii interface.

Administrator status

To log on to the EFI Splash RPX-iii with Administrator privileges, choose Server:Login and
type the Administrator password. By default, the password is blank.

Set a password to protect the EFI Splash RPX-iii settings against unauthorized changes. For
more information, see the Configuration Guide.

NoTE: Logging on to the EFI Splash RPX-iii with Administrator privileges allows you to
change the EFI Splash RPX-iii preferences and settings and use all the utilities. If you do not

log on with Administrator privileges, some functions are unavailable.
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Utility toolbar
The EFI Splash RPX-iii utility toolbar allows you to access EFI Splash RPX-iii applications

and utilities.

TO USE THE

TOOLBAR

¢ To open any of the utilities displayed in the toolbar, click the utility button.

ColorCal CopyCal Profile Loader ColorTuner Color Tweak SetBuilder Scan Start/Stop

¢ s 9 € da

The default toolbar displays buttons for the following utilities:

ColorCal allows you to perform color calibration. For more information, see the

Color Guide.

CopyCal allows you to create color profiles that simulate the output of any color printer.
For more information, see the Color Guide.

Profile Loader allows you to add ICC profiles. For more information, see the Color Guide.

ColorTuner allows you to edit the color output of a RIPped job before all the copies are
printed. For more information, see the Color Guide.

Color Tweak allows you to change the color output by editing the CMYK curves and
reprint the document without reRIPping.

Set Builder allows you to combine several jobs, printing them as a single, collated
document. For more information, see page 91.

Scan allows you to scan jobs directly from the EFI Splash RPX-iii. A separate Adobe
Photoshop plug-in allows you to scan with Photoshop.

Start/Stop allows you to start and stop jobs in process.

You can add buttons for the following utilities and features:

Spot Color Editor allows you to add and delete spot colors and change the value output for
any spot color. For more information, see the Color Guide.

Tray Alignment allows you to set vertical and horizontal print offsets that result in accurate
alignment of print margins and crop marks, for either single-sided jobs or duplex jobs.

Color Profiles allows you to select color profiles. It includes a link to Profile Loader.
For more information, see the Color Guide.

Mixed Media allows you to specify different paper types and trays for individual pages or
ranges of pages within a single job. For more information, see page 97.

Schedule allows you to set a time at which a job automatically prints. For more
information, see page 109.
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* Preflight checks jobs spooled at the EFI Splash RPX-iii for printing errors before the job is

processed. For more information, see page 35.

* Color Postflight outputs input colors as a tint of a specific primary output color, depending
on what type of job and what type of color the input is. For more information, see page 35

and the Color Guide.

You can use the following controls to customize the look of the toolbar:

* Separator puts a vertical line in between two icons, which can be used for grouping related

buttons and differentiating functions.

* Space puts a fixed amount of space in between two toolbar icons.

* Flexible Space used to right justify toolbar icons by putting as much space as there is room
between two toolbar icons. If you shrink the window, or add more icons on either side, the

space shrinks accordingly.

Changing the toolbar display

Change the toolbar display by adding or removing buttons in Splash Server Preferences.

For more information about setting preferences, see the Configuration Guide and the

Color Guide.

To CHANGE THE TOOLBAR DISPLAY

1
2
3

Choose Preferences from the Splash Server menu.

Click Button Bar.
To add or remove buttons from the toolbar, drag them to or from the Loaded Buttons list.

To add space and lines between buttons, drag the Space, Flexible Space, and Separator

controls into place, and then click OK.

Splash Server Preferences

CLOe6 9 & W

Server Page Network Color Appearance  Button Bar Jobs Job Logging

Available Buttons

Loaded Buttons

@J ColorCal

¥ Profile Loader
Ll
«@ CopyCal

ColorTuner

ﬁ Color Tweak
i‘_ SetBuilder
i Scan

= Spot Color Editor
A

. Tray Alignment

@E':I ColorCal N
= Profile Loader
v

< s ColorTuner

@ Color Tweak

i,:_ SetBuilder

+ Rush Print

PN Flexible Space

Separator

J
i @ Start/Stop 2
I 4

To customize the buttons displayed, drag items into or out of the Default Set

Loaded Buttons table.

1)

(G @50
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Start/Stop button

The Start/Stop button allows you to start and stop processing files.

Start/Stop

These actions are global, and will start or stop all print jobs currently on the EFI
Splash RPX-iii.

Client workstations can send print jobs to the EFI Splash RPX-iii while processing is stopped.
Jobs sent while the server is stopped are spooled to the startup disk and appear in the Active
queue. To control client printing, you can configure the EFI Splash RPX-iii to spool and hold
all incoming print jobs, allowing the administrator to review jobs and determine job
priorities.

If a print job is listed in the Active queue when server processing is halted, the EFI

Splash RPX-iii stops all jobs at the first logical stopping point and leaves them in the Active
queue, except for currently RIPping or printing jobs, which may return to the Hold queue.
Job order is not affected by this option.

To START AND STOP JOB PROCESSING

1 To start or resume processing, click the Start/Stop button or choose Server > Start Processing.
The logo background to the right of the button changes from red to green.

2 To stop processing all jobs currently on the EFI Splash RPX-iii, click Start/Stop, or
choose Stop Processing from the Server menu.

The logo background to the right of the button changes from green to red.
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Print queues

The print queues in the main window display the Active, Hold, or Error status of all

spooled jobs.

* Active queue displays the currently processing print job and jobs awaiting automatic
processing.

* Hold queue lists print jobs that the server has processed and jobs sent to the server with the
Send and Hold option set, or jobs dragged directly to the Hold queue.

* Error queue lists print jobs that failed to print, partially or completely.

Preferences for job processing that determine whether a job is sent to the Active queue or the
Hold queue are set in the EFI Splash RPX-iii Server Preferences and in the File Handling
print options. For more information, see the Configuration Guide and the Printing Guide.

When you set up a Hot Folder, you specify settings for job processing on the File tab.

Job management of the print queues is described in the following procedures.

To RESIZE A PRINT QUEUE

¢ To resize a print queue, click the divider that separates the print queues and drag up or down.

NoTE: You cannot resize a queue to hide another queue.

TO SELECT JOBS IN A PRINT QUEUE
¢ To select a job in one of the print queues, click the job.

¢ To select multiple jobs consecutively, click one job, press Shift, and click multiple jobs in
the queue.

¢ Press Command and click to select multiple non-consecutive jobs.

If a selected job has a preview image, it appears in the Preview window of the main window.

To MOVE J0BS BETWEEN QUEUES
® To print a job in the Hold queue, drag the job to the Active queue.

¢ To move a job to the Hold queue, drag the file from the Active or Error queues. You can also
select a job in the Active queue and choose Hold from the Jobs menu.

¢ To resume processing of a job in the Hold queue, drag the job to the Active queue, choose
Remove Hold from the Jobs menu, or press Command+R while the job is selected.
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To REORDER JOBS IN THE ACTIVE QUEUE
¢ Reorder jobs in the Active queue by dragging them to a new position within the queue.

Moving jobs in the Active queue allows you to reschedule jobs for RIPping or printing
without putting them on Hold.

Reordering jobs in the Active queue does not affect the current state of the job. Once a job
begins printing or RIPping, it continues to do so until it finishes or is placed on Hold.

When the currently RIPping job finishes and moves to the Print Pending stage, the job in the
Active queue that is Pending (highest in the queue) begins RIPping, and so on through all the
jobs in the Active queue.

TO DELETE A JOB

¢ To delete a job from the Hold or Error queues, select the job and press the Delete key on the
keyboard. You can also select the job and choose Delete Job from the Jobs menu.

* To delete a job that is currently processing in the Active queue, select the job, drag it to the
Hold queue, and then press the Delete key on the keyboard. When the job is in the Hold
queue, you can also select it and choose Delete Job from the Jobs menu.

A dialog box prompts you to confirm this action. If image files are saved, you are asked to
delete the entire job or just the saved images.

NoTE: You can also delete jobs by dragging them to the Trash icon on your Mac OS desktop.
Jobs in the Active queue cannot be deleted.

To ACCESS PRINT QUEUE JOB OPTIONS

1 Select a job in any print queue and click the arrow button on the upper-right side of
the queue.

You can also access the options from the Jobs menu.
2 Click an option to choose it.
3 To edit job settings, click Edit Job.

For more information about print queue job options, see page 136. For more information
about job settings, see page 26 and the Printing Guide.
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Cover Flow view

The Cover Flow view provides an alternative way of viewing jobs in the Hold queue. In the
Cover Flow view, a preview of the first page of each job in the Hold queue is displayed. If the
job has not been RIPped (processed), a standard placeholder is displayed. By clicking
thumbnails using the scrollbar, you can scroll through the list of jobs in an intuitive manner.
Preview display relative page sizes.

To PREVIEW COVER FLOWS
1 Drag a job to the Active queue to RIP (process) or print.

2 Click the Cover Flow control.

3 Click the job to select it in the Hold queue and move it to the center of the Cover Flow view.

1 Cover Flow windows
2 Cover Flow control
3 Divider

lo Document User Size Pages Spool Time Completio| »
q iMovieAtAGlance.pdf Dropped File 2.1 MB 10 3/17/08 248 PM  4/14/08 2
q Scanner Target.ps admin 191 KB 1 3/159/08 12:47 PM 4/14/08 2

i t__'_'_'_"_';'___' _____ — _'_"____'_'_"'___;'_"_"'_'L'_'_.i' = e

Use the divider between the Cover Flow view and the list view or the Cover flow control to
change the size of the view. You can also use the divider between the Cover Flow view and the
list view to hide the view entirely.

4 Double-click the centered job to open it in the Job Edit dialog.

NoTE: If the text search filter is in use, only jobs matching the search criteria display in the
Cover flow view (see page 22).

NoTe: Multiple jobs cannot be selected. If multiple jobs are selected, the first one selected
remains centered in the Cover Flow view.
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Print queue column headings

To modify the column headings in the print queues, use the following procedure.

To MODIFY PRINT QUEUE COLUMN HEADINGS

¢ To resize or reposition a column heading in the Active, Hold, or Error queues, click the column

heading and drag right or left.

To add a column heading, click the arrow to the right of the queue, select Add Column, and
select from the list of possible headings.

To change a column, Control-click an existing column heading and choose from the list of
possible headings.

To delete a column heading, Control-click the column heading and choose Remove Column.

For a list of all the available print queue column headings and a brief description of each,
see page 130.

The following section provides additional information about specific print queue column
headings.

Info field

On the EFI Splash RPX-iii interface, the leftmost column in the Hold queue acts as a job
information field.

The Info field has two display options:
* Info-Basic displays a symbol that shows the job’s most significant status.

* Info-Detailed displays symbols that show all possible statuses of the job.

To SELECT AN INFO FIELD DISPLAY OPTION

¢ To toggle from one option to the other, control-click the Info column heading, and then

choose Info-Basic or Info-Detailed from the menu that appears.

In the Active queue, the Rip and Print status of a job is available in the Status field. When a
job moves to the Error queue, the reason the job failed to print is displayed in the Error
Message field.

Hold b
ﬂ 1 Fize & |User Pages Spool Time |L
: 18.6 ME 8355D-ZignPamphletHiRe... Dropped File 12 2/8/08 11:44 AN

R 11.7 ME Altona_Visual_lvZa_x3-1.pdf Dropped File 1 2/B/08 11:44 AN
i 16.1 MB Interior_Magazine_Sample... Dropped File 1 2/8/08 11:43 AN
- 6.4 ME PriceListDemoSampleLTR.pdf Dropped File 28 2/B/0D8 11:45 AN

P 27.6 ME Splash_Sample_MagCovers... Dropped File 1 2/B/08 11:44 AN

™
o
.

[»
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Clock Symbol: Job scheduled to print at a later time

W: Color Tweaked

* I: Has Saved Rasters (Image)

» T: Will Apply Color Tuning When Run (Tuning)
e D: Has Preflight Report

e R: RIPped (previously processed)

* S: Receiving From Network (Spooling)

NoTe: For Info-Basic jobs for which more than one status condition applies, the field
displayed is according to the hierarchy listed previously. For example, for a job with saved
rasters and a preflight report, “I” is displayed in the Info field.

b ]

Size Document User Pages Spool Time |L
18.6 ME 8355D-ZignPamphletHiRe... Dropped File 12 2/8/08 114
6.4 ME PriceListDemoSampleLTR.pdf Dropped File 28 2/B/0B 114
11.7 ME Altona_Visual_lvZa_x3-1.pdf Dropped File 1 2/8/08 11:4
16.1 ME Intericr_Magazine_Sample... Dropped File 1 2/8/08 11:4
27.6 ME Splash_Sample_MagCovers... Dropped File 1 2/8/08 11:4
—) Al

The Info-Detailed option displays six columns of color icons that indicate the progress of
a job.

* I: Saved Raster, prints without reRIPping, symbol is Magenta if it has saved rasters,
blank if not.

* T: Applies Color Tuning When Run, symbol is Purple if it applies Color Tuner,
blank if not.

o D: Preflight Report, symbol is Gray if a report is generated, blank if not.
e R: RIPped (previously processed), symbol is Yellow if processed, blank if not.

* S: Received/Receiving from network, symbol is Blue if received, half-filled blue

if receiving.
* W: Color Tweaked, symbol is Orange if job has been color tweaked.
* Clock Symbol: scheduled to print at a later date.

NoTe: More than one Info-detailed field can be displayed at a time.
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Text filter

The text filter control allows you to filter the list of jobs to display only those that match the
job name or user name entered.

Q

Preview window
Jobs RIPped at the EFI Splash RPX-iii include a preview image for each page of the job. If a

job has not been RIPped (processed), the preview is unavailable. Previews are automatically
stored for all pages when a job is RIPped.

The Preview window is not movable from within the main EFI Splash RPX-iii server
interface. However, clicking the magnifying glass button to the left of the Preview window
allows you to open a new Preview window that is not attached to the main window. You can
move and resize the new Preview window. The Preview window also displays the page number
of the thumbnail image.

To PREVIEW A JOB
1 Select a processed job in the Active, Hold, or Error queues.

2 In the Preview window, click the magnifying glass icon.

1 Magnifying glass icon F—— \

Device




USING THE EFI SPLASH RPX-iii

3 In the larger view of preview, use the arrows and the scroll bar to page through the document.
Resize the window by dragging the lower-right corner.

1 Use scroll bar and arrows 000 iMovieAtAGlance.pdf Preview
to page through document

Resizing handle

3 Job preview/Page
preview toggle

o o

The larger view of preview allows you to switch between page preview mode (above), which
shows each page at high resolution, and job preview mode (below), which shows layout

options, such as duplex.

1 Use scroll bar and arrows o000 iMovieAtAGlance.pdf Preview
to page through document
2 Resizing handle

3 Job preview/Page
preview toggle

© O
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Status indicators

Last calibrated icon

Information about the status of the digital press trays and the EFI Splash RPX-iii is displayed
in the lower-right side of the EFI Splash RPX-iii server interface.

* Device DP700 displays the status of the printer, including up to three error conditions or

warnings. The installed paper trays are also displayed, showing the paper sizes they
accommodate. The type of paper installed in the digital press is visible by dragging the
cursor over the tray status bar. The amount of paper currently in each tray is also visible:

— Display bars are green if trays are greater than 50% full.
— Display bars are yellow if trays are between 25% and 50% full.
— Display bars are red if trays are 25% or less full.

The Device status also displays digital press out of paper, paper jam, and low toner
information.

Splash displays EFI Splash RPX-iii status, network activity, the date of the last calibration,
and available hard disk drive space. It also displays the connection status for the AppleTalk
and IP network, the status of the connection with the Fiery, the AppleTalk name, and the
IP address.

Last Calibrated displays the date and time the ColorCal calibration utility was last run.
For detailed information about when each Calibration Name was last calibrated, select the
icon next to the Last Calibrated field. For more information, see “To view Color
Calibration Summary” on page 25.

Disk Space Available shows the available space on the EFI Splash RPX-iii hard disk, both

numerically and visually.

DC700
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To vIEw COLOR CALIBRATION SUMMARY

1

EFI Splash

Click the icon next to the Last Calibrated field.

For each calibration name, the display indicates the date of the last calibration or indicates

that no calibration has been performed.

O O O  Color Calibration S y
Name ‘Warn | Calibration Date
Coated 220 gsm M Mot Calibrated
Cover 250 gsm i) Mot Calibrated
Label 110 gsm i) Not Calibrated

Select or clear the check box in the Warn column for each of the displayed calibration names.

By default, the Warn check box is selected, and a warning that the calibration is out of date is
displayed in red next to the Last Calibrated field in the EFI Splash RPX-iii server interface.

NoTe: Initially the Summary list is empty and the server warns you that the system is not
calibrated. As you calibrate media, those media are added to the Color Calibration Summary
with Warn enabled. If you stop using a particular media that you previously calibrated, you
can disable the Warn check box to avoid receiving warnings for media no longer in use.

For more information about calibration, see the Color Guide.

RPX-iii main menus

The following menus are displayed on the EFI Splash RPX-iii: Apple, Splash Server, File,
Edit, Server, Profiles, Jobs, Window, and Help.

NoTE: If you do not log on to the EFI Splash RPX-iii with Administrator privileges, some
commands in each menu may be disabled or View only.

For a description of the menus, see page 131.
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Job Settings

The Job Settings dialog box allows you to view the options for jobs in the Hold or Error
queues and revise them.

For information about the specific job settings, see the Color Guide and Printing Guide.

To EDIT JOB SETTINGS

1 To open the Job Settings dialog box, double-click the job in the queue or select the job and
choose Edit Job from the Jobs menu.

2 Click the tabs in turn to edit the job settings.

Summary displays job details. If a Preflight report has been run, the Preflight Report button
is enabled. Click it to access the report. A preview of the job is also displayed.

JDFInstall. pdf

» ok B ELEDFO

Summary File Page Imposition Tray Output Color Quality Extras Info

Document: |DFinstall. pdf
O [ror i caenan

Filename: Spool 0000000F -
File Size: 1.7 MB
Application:
User: Dropped File

Account:

Total Pages: 46

Page Size: Letter LEF - r - £ >
Received: Thursday, March 13, 2008 2:56:38 PM US/Pacific e
Scheduled: Job not scheduled

Comment:

Status

Held

Crm ) (Concel) (@0ED)
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File displays file-handling options.

untitled

oo M E @ Y

File | Page Imposition Tray Output Color Quality Extras

o' File dli

() Process and Hold

() Print and Hold

(%) Print and Delete

) preflight and Hold

() Color Postflight and Hold
() Postflight Report and Hold

Scheduli

' ! Daily Scheduled Time

=)
12:00:00 AM |}

X

Page displays page handling options.

iMovieAtAGlance.pdf

%o [4 S L6 0yYo

Summary File | Page |Imposition Tray OFpul: Color Quality Extras Info

Copies . Job dli
1 # Collate
[ Rotate Pages
] Face Up
Page Range
® an ) Even Duplex: = No Duplex B
O selected O odd
1- [l Force Paper Size
example: 3, 5, 10-20, 25- —

Paper: Letter LEF
Orientation: | Automatic
Scaling:  Mone
Percentage: 100

Position: | Center

[ Preflight Report... ) (: Print ) CCan(eI) G—Olhg




USING THE EFI SPLASH RPX-iii

Imposition displays imposition options.

iMovieAtAGlance.pdf

fél@miLLCQj‘Ie

Summary File Page Imposition Tray Output Color Quality Extras Info

@ Imposition Presets... -

position Type

Type: | Saddle-Stitch =

Section Size: | All ¥

(
Cover: |_None

ar

! Duplex

Media Type: Docu 2] N/A

Tray: = Document Default

Output
Output Paper Size: = Tabloid [
] Scale to Fit
Crop Marks: | 0.3 in. (7.5 mm) %

Changes that you have made will require the job to be ripped again.

([ Preflight Report. ( Print ) (Can(el) ( 0K )

Tray displays tray and media handling options.

iMovieAtAGlance.pdf

Summary File Page Imposition | Tray OIput Color Quality Extras Info

Tray Selection

G Automatic C Tray 1 C Tray 4
C Tray 2 C Tray 5
) Tray 3
Media Type
Media Type: | Tray Default H-!

Automatic — Copier Paper Type Priority
Other — Copier Tray Setting

Media Quality:  Use Machine Settings =

( Preflight Report... ) ( Print ) (Cancel) H
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Output displays finishing options.

iMovieAtAGlance.pdf

?(b[@ﬂigcﬂ\lﬁ

Summary File Page Imposition Tray Output Color Quality Extras Info
= Staple/Punch
Content Orientation: 3
Finishing:
Staple: None
@ None
() Staple/Punch
Punch: None

() single Page Folding
Position:  Left

() Booklet
[ ] Z-Fold Half Sheet

Single Page Folding

Qutput Destination:
! Finisher Stacker Tray H"
™ Offset Mode

Style: | Single Fold

Booklet

Fasten Mode: _ Fold
Feld and Staple ;

C Print ) (Can{el) f—ﬁlh";

( Preflight Report... )

Color displays color handling options.

iMovieAtAGlance.pdf

ol ] 2 LEdXO

Page Imposition Tray Output Color Quality Extras Info

Summary  File

Color Mode: () Contone ® screened Active =)

Color Model: &) Calor O Grayscale

™ RGB Color Management

s O profile: Apple RGB +)
@ standard

Gamma: | Dark (2.2} B
White Paint: | More Blue (9300) %)

(] Press Simulation
| Use Embedded Profile

Output Profile

¥ CMYK Color =
Rendering Style

-
Press Profile: | CGATS SWOP )
[ Preserve Original GCR T [Relative Colorimerric [%) (7) [ [printer's Defaukt [3)
) use Embedded Profile

Spot Colors J

™ Match Spot Colors

Black

# Use Black Ink Only
™ overprint Black

() (Gomee) 56D

Preflight Report.
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Quality allows you to set text and graphic printing options.

iMovieAtAGlance.pdf

»®E L 206070

Summary File Page Imposition Tray Output Color Quality | Extras Info

) Image Smoothing

E Text/Graphics Edge Enhancement
E Show Compaosite Overprints

) Auto Trapping

_| Gradient Smoothing

] PDF/X-3 Compliant

Text/Graphics Quality: ® Normal
O Best

Gloss Level: @ Normal
O Enhanced

! Apply ColorTuner

( Preflight Report... ) ( Print ) (Can(el) HH

Extras displays settings for file handling and prepress features. It also allows you to
schedule jobs.

iMovieAtAGlance.pdf

RN Rl )

Summary File Page Imposition Tray Output Color Quality |Extras | Info

Prepress Features Other

[ Invert Image

Separations: = Automatic B‘ [ Mirror Image

[ Print in Own Color
(| Use PDFX Dbjects

] Print Progressives [ save as TIFF:

[ Print Info Strip DPI: 72 (72 - 600}

( Preflight Report... ) (: Print ) (Can{el) (—GK—)
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Info displays job details.

iMovieAtAGlance.pdf

fold W £ L6 d O

Summary File Page Imposition Tray Output Color Quality Extras | Info

Document: iMovieAtAGlance.pdf

User: Dropped File

Password:

Account:

Comment:

PDF Password:

( Preflight Report... ) ( Print ) (Cancel) ﬁ
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Default job settings

Default job settings allow you to set default print options for jobs that are not sent with a EFI
Splash RPX-iii PPD, or for jobs that are sent with specific job options set to Printer’s default.
The settings include all color correction and printing modes, as well as paper types. The

Default Job Settings dialog box appears when you choose Edit Defaults from the Jobs menu.

NoTe: You must log on with Administrator privileges to modify the default job settings.

Editing default job settings

The following procedure explains how to edit the default job settings.

To CUSTOMIZE DEFAULT JOB SETTINGS
1 Choose Edit Defaults from the Jobs menu.
The Default Job Settings dialog box appears.

2 Click the File, Page, Imposition, Tray, Output, Color, Quality, and Extras tabs, and specify the
settings on each.

3 Click OK to save your settings.
The EFI Splash RPX-iii applies the default job settings in the following situations:

* To graphics files (EPS, TIFF, TIFF/IT, CT/NLW, PSD, PDE PDF-X1/a, ExportPS, and
PDF2Go formats) or PostScript files that are placed in the Drop Folder or dragged to the
Active or Hold queues.

* To graphics files received from a client on a TCP/IP network.

Default job settings for PostScript printing

The default job settings are set at the EFI Splash RPX-iii. For jobs that are not sent with a EFI
Splash RPX-iii PPD, default job settings are applied. Job defaults are applied to jobs from the

following sources:

¢ Jobs from UNIX clients

*  Mac OS jobs using non-Splash PPDs

*  Windows 2000/XP/Server 2003/ Vista jobs using non-Splash PPDs

* Jobs from clients with print options specified as Printer’s default
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Managing raster files

Raster files can be saved using the File Handling job options: Process and Hold or Print and
Hold. Jobs with saved raster files can be reprinted without reRIPping, depending on the EFI
Splash RPX-iii Server Preferences and job options selected. For example, calibration does not
require reRIPping. When a job is edited in such a way as to require reRIPping, you are
warned that the raster files associated with the job will be deleted. You must confirm or cancel
the edits.

The following options require reRIPing:

* File: All File Handling options

e Output: Staple

* Page: Page Range, Duplex, Force Paper Size, Scaling, and Rotate options
* Imposition: Imposition options

* Tray: Tray Selection, Media Type Selection

* Color: All options

* Quality: All options

* Extras: All options

Editing the EFI Splash RPX-iii Server preferences does not cause jobs to be reRIPped.
Some jobs may require that you delete the raster file and reRIP the file so that changes in a
preference take effect.

To DELETE RASTER FILES

¢ Select the job and choose Delete Images from the Jobs menu.

Delete Images
I _‘: Are you sure you want to delete the saved raster
images for the selected job(s)?

(Cancel){"' Imag }

A dialog box prompts you to delete the saved raster images. You can also choose to cancel
deletion of the raster files.
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Processing jobs
The EFI Splash RPX-iii includes the following options for processing print jobs.

RIP-While-Print

Automatic RIP-While-Print reduces print wait time by ensuring that the EFI Splash RPX-iii
is never idle while jobs are present. RIP-While-Print tracks all print jobs, including jobs that
are in transit to the EFI Splash RPX-iii, and directs Adobe CPSI (Configurable PostScript
Interpreter) processing of jobs, where the currently processing job has the highest priority.

RIP-While-Receive

Automatic RIP-While-Receive reduces print wait time by ensuring that the EFI

Splash RPX-iii is never idle while print jobs are present. RIP-While-Receive tracks all print
jobs, including jobs that are in transit to the EFI Splash RPX-iii, and directs CPSI processing.
The currently processing job has the highest priority and is completed first, regardless of
whether another job has been spooled.

NoTEe: In environments where very large jobs are printed, consider disabling RIP-While-
Receive to allow small jobs to print before large jobs finish spooling. Disable RIP-While-
Receive by using the Server Preference on the Network pane.

If an error occurs, a job is moved to the Error queue when spooling finishes. You can restart
the job when the error is corrected. It is not necessary to resend the job from the client.

RIP-Across-Jobs

The EFI Splash RPX-iii automatically begins RIPping a second job as soon as the first job
finishes RIPping. It does not wait for the first job to finish printing.

Instant Reprint

Instant Reprint allows RIPped files to print repeatedly without RIPping the job for each
repetition. Jobs with an “I” shown in the print queue Info-Detailed field print without

reRIPping.

NoTe: Instant Reprint is a EFI Splash RPX-iii server function and requires no action from the
user. Changing some job settings may cause the job to reRIP. For a list of these settings, see

page 33.
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Print Consecutive Jobs

The EFI Splash RPX-iii starts printing the next available job immediately. The EFI

Splash RPX-iii does not require the digital press to cycle down before printing the next job.
If a job does not become available within 30 seconds, the EFI Splash RPX-iii cycles down the
digital press.

Checking job errors

The EFI Splash RPX-iii provides the following features for checking for job errors before
printing: Preflight, Color Postflight, and Job Error controls. You can find out if errors exist in
a file by using Preflight. To identify the elements in the file that are causing the problem, use
Color Postflight. To print error reports and to define whether or not to print jobs with errors,
use the Job Error control.

Preflight

The Preflight feature allows you to examine jobs before they print for potential problems, and
produces a viewable and printable text report. Potential problems include the following:

* PostScript errors

* Missing fonts and font substitutions

* Color mode of each item (RGB, CMYK, Spot) in the file
* DPagesize

* Spot colors not defined by the EFI Splash RPX-iii

To SCREEN A JOB FOR POTENTIAL ERRORS

1 Select the job in the print queue and choose Preflight from the Jobs menu.

The job is moved to the Active queue for preflight processing, then moved to the bottom of
the Hold queue when processing is complete.

2 Choose Show Preflight from the Jobs menu.
The Preflight Results dialog box appears.

3 Click Print to print a hardcopy report.

4 Click OK to exit.

You can now use the Preflight report to identify and fix any errors.

If a job in the Error queue passes Preflight inspection, the job moves to the bottom of the
Hold queue.
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Color Postflight

The Color Postflight feature allows you to determine where problems are. When you run a
Color Postflight check, a color-coded printout of the file is produced.

To RUN A POSTFLIGHT CHECK
¢ Select the job in the print queue and choose Color Postflght from the Jobs menu.
¢ Select the job in the print queue and click the Color Postflight icon in the toolbar.
¢ With the job open, select Postflight and Hold on the File Handling tab of the printer driver.

The job is moved to the Active queue for preflight processing and printing, and then moved
back to the Hold queue when processing and printing are complete. As the job is processing, a
preview of the Postflight is displayed in the Preview window.

In the printed Postflight of the job, all CMYK data (text, graphics, and images) prints in cyan,
all RGB data prints in Red, all Spot data prints in yellow, and all grayscale data prints in
grayscale.

If you decide to convert one mode of color data to another, for instance, CMYK to Spot color,
use the Color Tuner application. For more information about Color Tuner, see the

Color Guide.

Postflight Report

Postflight Report generates a PDF that includes a 72-dpi preview of the Color Postflight
output, along with the information from the Preflight Report. The generated PDF is
automatically saved to a Postflight Reports folder on the Splash RPX-ii Macintosh desktop.

TO CREATE A POSTFLIGHT REPORT

¢ Select the job in the print queue and choose Postflight Report from the Jobs menu.

e With the job open, select Postflight Report and Hold on the File Handling tab of the printer
driver.

Job Error report

The EFI Splash RPX-iii allows you to screen a job for potential errors and print an error
report.
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TO PRINT AN ERROR REPORT

1 Select the job in the Splash Server window and choose Preflight from the Jobs menu.

The job move temporarily to the Active queue for preflight processing. If the job is in the
Error queue and passes preflight inspection, it moves to the bottom of the Hold queue.

2 When processing is complete, select the job in the Hold queue and choose Show Preflight
from the Jobs menu.

3 Select Print in the Preflight window to print preflight report.

For more information, see page 109 and the Configuration Guide.

Job Error Handling

Job Error Handling allows administrators to specify how to handle jobs that contain problems
and may not print correctly. This allows administrators to automatically prevent jobs from
printing with undesirable output or to generate an alert for potential problems.

For each error type, the administrator can configure one of the following:
* Ignore: Ignore the error and print the job following the normal File Handling settings.

e Warn: Print the job and return it to the Error queue with a warning message describing the

problem.

* Error: Do not print the job and return it to the Error queue with an error message
describing the problem.

For example, in a work environment where jobs are sent to different printers, fonts not
embedded may result in an inaccurate proof if the font is resident on the Splash Server,

but not actually included (embedded) in the job. The administrator can set the category
“Font not included in job” to Error, which generates a report of the missing font, or to Warn,
which allows the job to print and return it to the Error queue with a warning message
describing the problem.

The Splash Server searches for errors in the following categories or conditions:

Problem category/condition Default Notes

RGB Colors Ignore

Spot Colors Ignore

Spot Color not defined Warn NOTE: Unknown Spot Colors report

warning or error for both Composite and
Separations files.
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Problem category/condition Default Notes

Media Type not calibrated Ignore

Untagged RGB colors Ignore

No Output Intent on PDF/X-3 file  Ignore NOTE: This option only checks for errors if

the PDF/X-3 Compliant checkbox is
enabled in job options.

Not PDF/X-3 compliant Ignore NOTE: This option only checks for errors if
the PDF/X-3 Compliant checkbox is
enabled in job options.

Font not available Ignore
Font not included in job Ignore
Low resolution images Ignore

Low resolution DPI 72 DPI
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ADVANCED FEATURES OF THE EFI SPLASH RPX-iii

This chapter describes some of the advanced job management tools provided on the
EFI Splash RPX-iii. These features include the following:

* Tray Alignment

* Print Info/Control Strip
e Secure Access

* Screening Preferences

* Job Log Options

* Imposition

NoTe: If you do not log on to the EFI Splash RPX-iii with Administrator privileges, some
commands in each menu may be disabled or View only.

Tray Alignment

Tray Alignment allows you to set vertical and horizontal print offsets that result in the
accurate alignment of print margins and crop marks, for single-sided jobs or duplex jobs.
The offsets are different for Side 1/simplex and Side 2. When you first open the Tray
Alignment dialog box, Side 2 is automatically selected. To align both sides, align Side 1,
and then align Side 2.

NoTEe: You do not have to align Side 1 before aligning Side 2. Unless Side 1 is noticeably
offset, you can proceed directly to aligning Side 2.

Tray Alignment supports the configuration of individual offsets for each tray. You can send
duplex jobs in automatic duplex mode to any tray.

Note: Align Side 1 to correct small offsets that occur during normal printing. If offsets for
Side 1 are greater than a few pixels, service the digital press. Clipping can occur with large
offsets.
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To SET TRAY ALIGNMENT

1 Choose Tray Alignment from the File Menu.

2 Click Side 1 and select a tray.

NoTe: If the front side of the pages in your job is centered to your satisfaction and all you
want to do is perform duplex alignment, proceed directly to the instructions for Side 2, which
start in step 9.

The Paper Size and Media Type are selected automatically.

[ Tray 1 ) [ sider side2 !
Paper Size: Tabloid
Media Type: 7777
Feed Direction: 0 pixels .
_— _
(& Direction: 0 ixel <
T ross Direction: pixels Verify
Print the Test Page to 2 Enter the values from the 3 See if the printout
find the tray's Test Page. is now aligned.
misalignment.
Cpams )

3 Click Test to print a Test Page.

4 Follow the instructions on the page to determine and enter the offset values in Feed
Direction and Cross Direction.

Click Verify and examine the printed target.
If the printed target is out of alignment, adjust the values.
Repeat steps 4 through 6, as necessary.

Click Update when the correct alignment is achieved.

O 00 N o U

To align for a duplex job, click Side 2.

— [ Tray1 )| side1 = sidez ]

Paper Size: Tabloid

Media Type: 7777

Print the Test Page to
find the tray's
misalignment.

2 Enter the values from the
Test Page.

H Feed Direction: 0 pixels .l
(e Direction: 0 ixel .f:f
o ross Direction: pixels Verify

3 See if the printout
is now aligned.

o) ()
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10 Select a tray.
The Paper Size and Media Type are selected automatically.
11 Repeat steps 3 through 8.

Tray alignment features

The following features in the Tray Alignment dialog box allow you to configure and print
simplex and duplex jobs.

* Test Pattern: Helps determine the offset values needed to center the output on a simplex
page and to properly align both sides of a duplex job. Select a tray, and then click Test.
A test pattern is printed using the offset values of “0” pixels for both the vertical and
horizontal offsets. The test pattern contains instructions for determining the correct offset
values, depending on whether you are performing alignment for Side 1 (simplex) or Side 2
(duplex). For simplex, measure the target with a ruler and calculate the adjustment, or
make a visual judgment of whether the output on the target is centered. For duplex, you
must align the patterns on both sides of the pages with each other.

* Verification Pattern: Displays the effects of the offset values. After you enter the horizontal
and vertical offset values, verify the results by clicking Verify. The verification target prints,
using the offset values that you entered. Review the printed target. If it is not properly
centered or aligned, adjust the values.

NoTe: To update the offset values without printing a verification target, select the appropriate
tray, and then click Update.

* Specify Offsets: The minimum Offset Value is -999 and the maximum is +999. If you
enter an offset that would cause a particular page size to print the margins outside the print
area, the margin is automatically changed to the maximum value. For example, the left
margin is -70 pixels. If you enter a value of -100 for the alignment offset, the margin is
changed to -70 for the duplex job. The Tray Alignment setting remains -100. If no offset
value is entered for a tray, the default alignment offset value is set to zero.

NoTE: If the Tray Alignment for Side 2 on the printer is extremely out of alignment, the test
pattern target may produce a false match and the verify target will not line up at 0, 0. In this
case, adjust the offsets manually until the verify target lines up at 0, 0.
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The Print Info feature allows you to print an information strip on a job. This assists in
tracking job settings used on different outputs of the same file and routing output back to the
originator. The information is printed on the top or bottom of the page, depending on the
location selected, and on every page of the job. When you set up Print Info preferences, you
can enable the Control Strip. The Control Strip is a set of color control patches on the edge of
the output.

Configuring Print Info

The configuration of Print Info determines content and location of the Print Info Strip.
To enable the Print Info Strip for a job, see page 44.

To configure Print Info, choose Print Info from the Server menu.

The Print Info dialog box appears.

Print Info

Page Handling Print Preferences

v
¥ Promote Page Size ¥ User Name
¥ Job Name
Juse Tray 5 if needed ¥ Job Comment

(¥ Date and Time of RIP

Tray § Size: | 12x18 | Original Page Size
| Page Number of Total Pages
I Spool File Size
Crop Marks [ Server Name

" Color Correction Settings
[¥ Print Crop Marks [ Calibration Name

[ Last Calibrated Time

Clinvert I Percent Enlarged/Reduced
I Spot Colors
Appearance Control Strip
Location: ¥ Control Strip
(®) Top ¥ Color Patches
() Bottom "] Gray Balance
= V] EPS File
G Name: [ Controlstipepst ¥)
7 : —

St Height: |0.40  in.

¥ou need 1o be logged in 25 administrator o save changes.

Ceamee) (o

Page Handling allows you to use the Promote Page Size option to print the job on the next
largest paper size available. Although the job is printed centered on the page, it is not scaled
to the new paper size.

NoTe: Selecting Force Paper Size from Job Options overrides this feature.

Crop Marks prints crop marks around the original image paper size of the job. If the Invert
option is selected and there is no room on the page to print the crop marks outwardly, the
crop marks are drawn into the page. If Invert is cleared and there is no room on the page to
print crop marks outwardly, crop marks do not print.
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Info Strip allows you to set the location where the Print Info Strip prints (top or bottom of
page), and the font size of the type.

NoTe: The Control Strip prints at the bottom of the page regardless of the Info Strip position
setting.

Print Preferences allow you to specify the information that is printed on the Info Strip.
The defaults are User Name, Job Name, Job Comment, and Date and Time of RIP.

Other options you can customize are:
* Original Page Size

* DPage Number of Total Pages

* Spool File Size

e Server Name

* Color Correction Settings (which include RGB, CMYK, Spot Color settings and output
profile names, if applicable)

¢ (Calibration Name

* Last Calibrated Time (indicates the last calibration time for the particular media, which
may not be the last time 27y media was calibrated)

* DPercent Enlarged/Reduced

* Spot Colors (unknown spot colors are shown with an X through them or as black,
depending on how the original was printed)

NoTe: Only the preferences you select are printed. If you do not select a preference in
Print Preferences, a placeholder is not printed on the page.

Control Strip allows you to enable the Control Strip and to specify options for it, including
Color Patches, Gray Balance, EPS file (name of file), and Height. The Control Strip image
overwrites the job image if it occupies the same part of the page. The Control Strip does not
print on paper sizes smaller than Letter.

Note: The EFI Splash RPX-iii provides a standard Control Strip, which can be replaced with
any other EPS formatted file.
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Enabling Print Info Strip

To enable Print Info Strip on a job-by-job basis from the EFI Splash RPX-iii or a client
workstation, you must edit Job Options.

To ENABLE PRINT INFO STRIP ON A JOB

Double-click the job in the Hold queue or select the job and choose Edit Job from the
Jobs menu.

The Job Options dialog box appears.

Click the Extras tab.

Select Print Info Strip in the Prepress Features section.
Click OK.

Drag the job from the Hold queue to the Active queue for printing.

NOTE: You can also enable Print Info Strip on the Default Job Settings: Extras tab.
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Secure Access

Secure Access allows you to limit who can print to the EFI Splash RPX-iii by defining
combinations of user names, passwords, and account numbers that must be entered and
verified before a job prints. You can also use Secure Access without the verification feature to
improve job logging, by requiring user names and account numbers before a job is printed.

Secure Access accounts are established and managed at the server. Users are prompted for the
required information at their workstation. Validation of the information, if required, is
performed by the EFI Splash RPX-iii. If the information is not valid, users are prompted to
re-enter the correct information before the job is printed.

To START SECURE ACCESS

1 Choose Secure Access from the Server menu.

2 Click Enable Secure Access.

Secure Access

8 Enable Secure Access

Required Information: Verify
E User \_’
E Password \l

) Account Number

) Exempt Drop Folder Jobs

Error Message Client Receives

Server Administrator's Email Address

(coneel ) (0K

3 Select the required options, and then select Verify to indicate which options are to be
verified.

You can choose to verify User, Password, and Account Number.

NoTE: If you select Password, you must select User, and select Verify for both settings.
With Password cleared, you can choose whether to verify User or not.

When the Verify option is cleared, the EFI Splash RPX-iii processes any job for which the
selected information appears. The User and Account Number are output to the Job Log file.

Note: Files placed in the Drop Folder or a Hot Folder, or dragged to one of the print queues,
always produce an error when Secure Access is enabled, unless you also select Exempt Drop
Folder Jobs. If this option is selected, the files print, regardless of the Secure Access settings.
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4 Type an error message.

When a user incorrectly enters Secure Access information at a client workstation, the

EFI Splash RPX-iii returns an error message at the workstation. Edit this error message to
provide specific contact information for users of a particular server. The maximum number of
characters allowed in the Error Message and E-mail Address fields is 255 characters.

Using Secure Access at client workstations

When Secure Access is configured at the EFI Splash RPX-iii, users must install the Secure
Access print driver provided with the EFI Splash RPX-iii. For installation instructions, see
Getting Started and the Printing Guide.

Printing with Secure Access

Printing using the Secure Access printer driver is the same as printing with the standard driver,
except that the driver prompts you for the Secure Access information. For applications that
provide a Print dialog box, such as QuarkXpress and InDesign, you must click the printer
button to be prompted for Secure Access information.
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Setting up Users

The Users feature allows you to set up users with Secure Access or scan templates.

For information about setting up scan templates, see page 116.

To SET uP USERS

1 Choose Users from the Server menu.

-
Users.
Username
Name: Operator
Password:
Verify:
F1=] €

a“ o n
+

2 In the Identity pane, click to add a new user.
3 Type the required information in the Name, Password, and Verify fields.

A maximum of 32 characters is allowed in the Name field. A maximum of 32 characters is
allowed in the Password field. An unlimited number of users can be added to the Users list.
However, if you try to enter a duplicate User, a warning dialog box asks if you want to
override an existing user.

4 Click OK.

5 To change the name or password for a user, select the user name in the Identity pane and edit
the information.

6 To remove a user from the list, select the user name and click “-".
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Accounts

Use Accounts to set up print accounts for use with Secure Access.

To SET uP ACCOUNTS

1 Choose Accounts from the Server menu.

Accounts

Account

Number:

Description:

+1=)

2 Click “+” to add a new account.
3 In the Number field, enter an account name and description, if required.

A maximum of 32 characters is allowed in the Number field. A maximum of 100 characters
is allowed in the Description field.

NoTe: Use alphanumeric characters only for Account names.

The account description allows you to provide more information about the account than
can be stored in the account name. The account description is not required and is not used
elsewhere by Secure Access.

4 Click OK.

5 To edit account information, select the account name and change the information in the
Number and Description fields.

6 To remove an account, select the account name and click “-".
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Screening Preferences

The Screening Preferences feature allows you to select screening methods, create custom
screens, specify lines per inch, and create sets of screening preferences. You can then switch
between common screening configurations without specifying the details each time.

To SET SCREENING PREFERENCES

1 Choose Screening Preferences from the Server menu.

Screening Preferences

Screen Preferences:

+ Default ( set Active )

( Edit. )
[ Duplicate b

r'd Y
- Delete )
L

Active Screen Preferences: Default

2 Click New to create a new set of screen preferences.

The Screen Preferences dialog box appears.

Screen Preferences
Screen Preferences Name: untitled preferences
Screening Method
() square Frequency: 85  Ipi
atr
Line — — — —
) (@) paml A rami0) vl
O Ellipse Angle: C: 15° |, M: 75" [, Y: 0O - K457 L)
(* Dot Spot Function:
() Custom { d )
1. sub
{ dup mul exch dup mul add 1. exch sub } X
ifelse
Reset

3 Make the appropriate selections and click OK.

Frequency and Angle are standard halftone terms. Spot Function is the PostScript code that
defines the halftone. To edit this, click Custom.
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NoTe: Entering incorrect PostScript code can result in incorrect output and PostScript errors.

The name you assigned to the set of screen preferences is displayed in the list of Screen
Preferences sets.

4 To modify a Screen Preferences set, select the name in the list and click Edit, Duplicate,
or Delete.

Job Log Options

You can view, print, or export the Job Log. The log is a tab-delimited text file that can be
imported into Microsoft Excel or other spreadsheet applications.

To PRINT AND EXPORT THE JOB LOG

1 Choose Print Log from the File menu.

The Print Job Log dialog box appears.

Print Job Log

Tray Selection: Sort By:
(®) Largest Paper Size O User
O Tray 1 (*) Date/Time
O Tray 2 (O Account Number
e Tray 3

| Output Subtotals

Print Entries:

() since Last Report
(=) All Entries

2 Select a paper tray, select the appropriate Sort By criterion, and then indicate whether to
print since the last printed report or all entries.

3 Click OK.
The Job Log is processed and printed.
4 To export the log, choose Export Log from the File menu.

If the log is successfully exported to the computer desktop, a message appears confirming that
the export was successful.

You can open the log on your desktop or export it to a spreadsheet application. You can also
choose to Show Job Log.

For information about the types of information displayed in the Job Log, see page 138.
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Job Log Viewer

The Job Log Viewer allows you to view, sort, and print the Job Log. You can add or remove

columns to the display, and change the font and the size of the font. Any changes that you

make to the view-only Job Log do not change the actual Job Log.

To VIEW THE JoB

LoG

1 Choose Show Job Log from the Splash File menu.

866

Q SplashPrint.log

Print

Q-

Search Log

107 log recar

rds

User
Dropped File
dannyl
Drop Folder
Dropped File
Dropped File
Dropped File
Chrisu
GaryL
Dropped File
dannyl
dannyl
dannyl
Gary L
Dropped File
dannyl
Dropped File
Dropped File
mollv
Dropped File
dannyl
Gary L
Chrisu
Dropped File
Dropped File
marks
JohnG
Dropped File
JohnG
JohnG
Dropped File
Dropped File

Document Account
2003DBPCal.pdf
2003DBPCal.ps
Architecture600CMYE.tif
BlackHole2004.pdf
BMW_Bro.pdf
BMW_Bro.ps
Bro_RCB_efi.ps
BRO_SING_CMYK.ps
CHESSBOARD. pdf
CHESSBOARD PS
CPG_B27p.PS
DOW30.PS
EFICALEN.PS
EFIGAP.pdf
EFIGAP.PS
FIERY_SI_DEMO35.PDF
FIERY_SI_DEMO35.PS
FieryKiller.ps
CATF.pdf

GATF.PS
INSERT_FL.ps
INSRT_SNGL.ps.
Italian_Bro.pdf
Italian_Bro.ps
NEWSPAPE.PS
PSHOPLTR.PS
PSv3Files.PS
QUARKLTR.PS
QUARKTAB PS.
5_Series_Bro.pdf
SCVTAMAP. pdf

(&

Status Date 4| Start

OK June 15,
OK June 15,
CANCELLED June 15,
OK June 15,
OK June 15,
CANCELLED June 15,
OK June 15,
CANCELLED June 15,
OK June 15,
OK June 15,
CANCELLED June 15,
OK June 15,

CANCELLED June 15,
CANCELLED June 15,
CANCELLED June 15,

CANCELLED June 15,
CANCELLED June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,
CANCELLED June 15,
OK June 15,
OK June 15,
OK June 15,
OK June 15,

2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006
2006

5:11PM
5:14 PM
5:17 PM
5:19 PM
5:23PM
5:26 PM
5:28 PM
5:30 PM
5:31PM
5:32PM
5:41PM
5:44 PM
5:47 PM
5:49 PM
5:51PM
5:53PM
5:55PM
5:58 PM
5:59 PM
6:01PM
6:02 PM
6:03 PM
6:08 PM
6:12PM
6:13PM
6:14 PM
6:16 PM
6:17 PM
6:18 PM
6:22 PM
6:24 PM

RIP
00:39
00:30
00:53
00:39
00:54
00:43
00:26
00:34
00:07
00:06
02:55
00:09
00:34
00:25
00:22
00:14
00:11
00:55
00:15
00:14
00:20
00:17
01:38
01:15
00:06
00:13
00:08
00:10
00:09
o01:25
00:18

.
v
]

2 To set Job Log Viewer Preferences, choose Preferences from the Job Log Viewer menu.

You can choose a font, specify the display size of the font, or specify the printing size of
the font.

800 Job Log Viewer Preferences

Log Font: | Lucida Grande

B

Display Font Size: 119

Printing Font Size: 7 B

3 To select which columns are displayed, choose View Options from the Edit menu.
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Select or clear the check box for each column name, and then click OK

View Options

Show Columns

¥ a g Account g Paper Size

o g Black Images Printed E Paper Type
E Color Images Printed E Print Time

g Color Model g RIP Time

] Comment 7] serial Number
| Capies [ size

E Cover Page E Start Time

g Date g Status

g Document E Tray 5

& Duplex ™ user

E Pages Rendered

G 0k

In the Job Log Viewer window, click the User column header to sort the data in ascending/
descending order.

Totals for each individual are shown. The totals are used for accounting purposes.

To show/hide column headers, hold down the Ctrl key and click a column header. Select an
item from the list to show or hide.

Click a column header to sort the information in the column.
Click a column header and move it to a new position.

To filter the Job Log to show only entries containing a key word, type the keyword in the
Search Log field.

To print the Job Log, click Print in the Job Log Viewer dialog box.
You can specify print options and page setup for printing the Job Log.
To view a previously exported Job Log, choose Open or Open Recent from the File menu.

You can then browse to the location of the exported Job Log,.
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Imposition and Booklet Printing

The Imposition feature allows you to rearrange the printing page order of a job to output
booklets. In some cases, this feature uses paper more efficiently for printing multiple copies of

small documents.

Booklet printing with presets

The quickest way to print a booklet is by using presets, which provide shortcuts to common

finished booklet styles.

To PRINT A BOOKLET WITH PRESETS

1 Select the job in the Hold queue and choose Edit Job from the Jobs menu, or double-click the
job in the Hold queue.

2 Click the Imposition tab and choose a preset from the Presets pull-down menu.

1 Presets pull-down menu Getting Started

0l 0@ YyO

Summary  File Page Imposition Tray Output Color Quality Extras Info

g Imposition Presets... Q
@ Booklet, Duplexed Cover
Imposition Type Booklet, Front and Back Cover
Type: | 4-up Saddle_Stitch = =  Booklet, Front Cover
Booklet, No Cover
{
Section Size: | All ) C! TS
g Edit Settings List...
Cover: | MNone i+ ——
! Duplex
Media Type: Docu : :
Tray Automatic &
(" Finishing._
Qutput
Qurput Paper Size:  Tabloid I:!
[ Scale to Fit ( Advanced... )
Crop Marks: 0.3 in. (7.5 mm} [
Preflight Report... (" print ) ( Cancel ) HH

3 Click Finishing and specify the Fasten Mode for your booklet.
4 Click Print.

If you create a booklet style that you use often, for example a finished booklet with a
particular media type for the cover, you can save a new preset (by choosing Save Settings from
the Presets menu) as a shortcut to those settings, to use for future jobs.

You can also select a preset to begin with something close to what you want, and then make
modifications to the options listed on page 54 to get the exact settings, without having to set
the nine options individually.
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Advanced booklet printing

The following steps are necessary to print a booklet from Mac OS or Windows clients or at
the EFI Splash RPX-iii. To print a booklet, you must select Saddle Stitch or 4-up Saddle
Stitch as the Imposition Type. When you do so, the booklet options are enabled, with the
defaults set to print a folded and stapled booklet with no cover.

To PRINT A BOOKLET WITH ADVANCED IMPOSITION SETTINGS

1 Select the job in the Hold or Error print queue and choose Edit Job from the Jobs menu, or
double-click the job in the Hold or Error queue.

2 Click the Imposition tab.

iMovieAtAClance.pdf

Summary File Page  Imposition Tray Output Color Quality Extras Info

E‘ Imposition Presets... -

Imposition Type

Type:

Saddle-Stitch 3

Section Size: _All T

Cover: None )

. Duplex

Media Type: Docu... Z N/A

Tray: Document Default

Output
Output Paper Size: W
[ Scale ta Fit
Crop Marks: m

Changes that you have made will require the job to be ripped again.

Preflight Report... ( Print ) CCanceI) ( oK )

3 Set the following options.
* Imposition Type: Saddle Stitch or 4-up Saddle Stitch (see page 56).
* Section Size: 4, 8, 16, 32, 64, or All (see page 56).
* Cover: None, Front, Back, or Front and Back (see page 56)

* Cover Duplex: On, Off (see page 57)
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* Media Type: Select paper for the Cover page only. All other pages use the media type and
tray selection from the Tray pane.

* Tray: Select Tray for the Cover page output only. All other pages use the media type and
tray selection from the Tray pane.

* Output Paper Size: Select a paper size at least twice as large as the original page size defined
for printing (see page 60).

* Scale to Fit: Select if required to fit the imageable output on the selected page size (see
page 61).

e Crop Marks: 0.1 inch (2.5 mm), 0.2 inch (5 mm), 0.3 inch (7.5 mm),0.4 inch (10 mm),
0.5 inch (12.5 mm) (see page 61).

4 Click Advanced to set advanced imposition options.

o666 Advanced Imposition Options
Gutter. Creep.
H
'
:
S H
Across: 0.00 in. ) Automatic
Down:  0.00 in. ) 0.00 in.
Bleed Crop Size
-~ + +
+ +
0.00 in. (*) Use Page Size
O 850 in. 11.00 in.
Width Height

5 Click OK to return to the main Imposition pane.
6 Click Finishing, select Booklet on the Finishing tab, and then select a Fasten Mode.
7 Click Print.
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Imposition settings

The available imposition settings are as follows:

Imposition Type
* Saddle Stitch and 4-up Saddle Stitch specify the layout and sequence needed for the

signatures (which are produced when printed sheets are folded correctly) that are stapled or
stitched at the center fold or spine. With saddle booklets, you can also specify a section
size, which defines the number of pages of the original document (not the same as the
number of sheets of paper) that are printed together in a single section. Saddle Stitch
booklets do not open fully or lie flat.

i
@ - @

Saddle Stitch prints two pages on each side of a duplex sheet. For example, a Saddle Stitch,
duplex print of a letter document prints two letter (8.5x11 in.) pages on the front of a
tabloid (11x17 in.) sheet and two pages on the back.

4-up Saddle Stitch prints four pages on one side of a duplex sheet.

NoTE: If a Saddle-Stitch document does not fill the page, the output will print justified to
the center of the output sheet so that when folded at the center and trimmed, it forms a

booklet.
Saddle options

— Section Size defines the number of input pages to print in a Saddle-Stitch layout.
This feature is enabled only when Saddle-Stitch is selected. All of the pages in a single
section are folded together as a group. For example, a 96-page document with 16-page
sections has six sections, each of which would be folded and then combined with the
other sections to create the booklet. Among other reasons to use this option is the fact
that if you use Saddle Stitch on a long document, the inmost pages stick out and
cannot be trimmed to create a flat edge for the booklet without losing page content.
For booklets which will be stapled and folded, or which will use a cover, the only
Section Size allowed is All. For booklets which will only be folded, you can select a
Section Size to match the number of sheets you want folded in a group.

— Cover allows you to specify a cover on the front, a cover on the back, a cover on the
front and back, or no cover.
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— Cover Duplex allows you to specify whether to print the cover as duplex or not. If you
select Cover as Front only or Back only and select Duplex, only the front or back, as
selected, will print duplex. There is no combination of selection that enables you to
duplex the front, but not the back, or vice versa.

— Cover Media type allows you to select paper if you have specified a cover page. All other
pages use the media type and tray selection from the Tray pane.

— Cover Tray allows you to specify a tray for the Cover page output only. All other pages
use the media type and tray selection from the Tray pane.

* Perfect Bound and 4-up Perfect Bound specify the layout and sequence needed for jobs that
will be folded, cut, and glued along the back spine into a cover or binding. In perfect
binding, only a single page is folded at a time. Perfect Bound publications are so called
because they open fully and lie flat. Most large trade books and larger magazines use this
technique.

1 Perfect Bound
2 4-up Perfect Bound

® @

Perfect Bound prints two pages on each side of a duplex sheet. Perfect Bound produces the
same output as Saddle Stitch with a 4-page section.

4-up Perfect Bound prints four pages on each side of a duplex sheet.

NoTE: If a Perfect Bound document does not fill the page, the output is printed centered
on the output page such that when folded down the middle and trimmed, it forms a
booklet.
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e Cut and Stack

Landscape simplex
Portrait simplex =) 3 =5 = y B 1 2
Landscape duplex E 2 = 1 = ) =) 0
Portrait duplex 1 1 1 2 =

n
& d{; 3 2| dﬁ
5 8| 7

S W N R

Cut and Stack prints two consecutive pages on each sheet of paper, so that when the sheets
are cut in half, then stacked, you have one complete set of the document at less cost (fewer

click charges).

¢ Signature

1 Landscape signature
2 Portrait signature E

. - 3|
"|| c

Signature prints two pages of the job, in order, on a single-sided sheet. Signature is often
used to print a proof of a document at a lower cost than printing the pages on separate
sheets. Signature is always 2-up, which means two document pages per side. Pages 1 and 2
print on the first sheet and pages 3 and 4 print on a second sheet. If Duplex is selected,
pages 3 and 4 print on the back side of the first sheet. Jobs with odd numbers of pages
print the last page with a blank opposite it.
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* Step and Repeat (Auto) and Step and Repeat (Fixed) print multiple copies of a single
document page on larger sheets to save paper and reduce cost (fewer click charges). The
copies print with external crop marks, but with no crop marks in the space between the
document pages, unless a gutter is defined (see “Gutters” on page 61).

1 Portrait simplex 1 1 1 T2

2 Landscape simplex

3 Portrait duplex L ] ] ] o
4 Landscape duplex ‘-cg ""'g

A | R
o @ 9 ®

Step and Repeat (Auto) automatically fills the sheet with as many copies as will fit on the
selected output page size. Step and Repeat (Auto) automatically rotates and centers the
document pages to fit the maximum number of copies per page. Step and Repeat (Auto)
supports duplexing, but not collation.

Step and Repeat (Fixed) prints the number of document pages that will fit on the selected
output page size, but allows you to decide the number and orientation of pages specified
by the Across, Down, and Orientation options. By controlling the replication across and
down, users gain greater control over the imposition, possibly at the cost of fitting fewer
pieces on the page. Step and Repeat (Fixed) supports duplexing, but not collation.

NoTe: With Step and Repeat (Auto) and Step and Repeat (Fixed), the Copies field on the
Page pane or printer driver specifies the number of sheets to print, not the number of
copies of the original document page.

¢ Step and Repeat options

— Content Orientation allows you to lay out the copies for Step and Repeat in landscape
or portrait orientation on the page. For Step and Repeat, this option essentially rotates
the content 90 degrees to allow you to align the content with the grain of the paper, if
necessary.

— Copies Across allows you to specify the number of copies across for Step and Repeat

(Fixed).

— Copies Down allows you to specify the number of copies down for Step and Repeat
(Fixed).

For information about printing registration marks with Step and Repeat jobs, see
“Gutters” on page 61 and “Setting application registration marks” on page 63.



S W N R

Portrait rotated
Landscape rotated
Portrait not rotated
Landscape not rotated
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¢ 2-up Imposition

@ @ ® @

2-up Imposition prints two copies of a single page on the selected output page size. 2-up
Imposition supports duplexing and collation. With 2-up Imposition, you have the option
to rotate or not rotate the two copies to modify the cutting edge (see Rotate 2-up below).

e 2-up Imposition options

— Content Orientation allows you to layout the copies for 2-up Imposition in landscape or
portrait orientation on the page.

— Rotate 2-up allows you to rotate the two copies to make the cut edge the right side of
both copies, but there may be slight differences in positioning of the content if the
sheet does not feed through the digital press with precise centering.

Disabling Rotate 2-up makes the content of both copies line up exactly, but the cut
edge is on the left side of one copy and the right side of the other.

Output Paper Size

* Automatic determines the output page size automatically as double the input page size.
Input page size is either selected from Page Setup in the printer driver at the client
workstation, or from the Force Paper Size option on the Page pane of the job options at the
server. This allows Letter LEF/A4 LEF documents to automatically print on Tabloid/A3,
as well as other similar combinations. Automatic is not available for Step and Repeat
(Auto) or Step and Repeat (Fixed).

* Output Paper Size allows you to specify the correct size for different imposition type
settings. For proper results with Saddle Stitch, Perfect Bound, and Signature, the output
paper size must be at least twice as large as the original page size defined for printing. For
example, for a Letter page, select Tabloid. For A4, select A3.

NoTe: The Custom Page sizes created in the Splash Server preferences are supported. For
more information about creating Custom Page sizes, see the Configuration Guide.
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* Crop Marks print only if there is room for them on the page. The imposed pages print
centered on the output sheet. If there is room to place full or partial crop marks, the crop
marks are added. To ensure that crop marks print, choose a page size that is more than
twice as large as the original page size defined for printing.

For Step and Repeat (Auto) and Step and Repeat (Fixed). the copies print with external
crop marks, but with no crop marks between space between the pages, unless a gutter is
defined (see “Gutters” on page 61).

If crop marks are printed for Step and Repeat (Auto), the size of the crop marks is taken
into account when determining how to fit the most possible copies onto the page.

Crop mark settings have the following measurements:

0.1 inch (2.5 mm)

0.2 inch (5 mm)

0.3 inch (7.5 mm)
— 0.4 inch (10 mm)
0.5 inch (12.5 mm)

Scale to Fit

* Scale to Fit allows you to scale the imageable output to fit on the selected page size.
Scaling preserves the aspect ratio, so the output page may not be completely filled. Scale to
Fit is not available when Step and Repeat (Auto) is selected.

Advanced imposition options
* Gutters

- -4~

Gutters add an extra margin to allow space for binding or other finishing options, or to
allow space for crop marks between document pages of Step and Repeat (Auto) and Step
and Repeat (Fixed). Gutters control whether crop mark print between Step and Repeat
document pages or only around the external edges of the sheet. If you define a 0-sized
gutter, you will get only external crop marks. If you define a larger gutter, you will get crop
marks between the copies. To see all of your crop marks, make the gutter at least twice the
size of the crop marks.
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* Creep

Creep compensates for the incremental shift in page content as the sheets are folded to
form saddle booklets. Automatic creep adjustment moves the content a fixed amount per
sheet based on the default values for the media types included in the booklet. Use Manual
creep adjustment to override those values for jobs or media that require a specific
adjustment.

¢ Bleed

‘-.@

Bleed defines the amount of the page to treat as bleed area instead of desired page
content. The Splash Server moves the crop marks the specified amount inside the page
content to show where to cut. For example, to create a 3x2in. (76x50mm) business card
from a 3.25x2.25in. (82.5x 57mm) document, create a 3.25 x 2.25in. (82.5x57mm)
custom page size, or specify a 3.25x2.25in. (82.5x 57mm) Crop Size, then define 1/8in
Bleed. The Splash Server will print 3.25x2.25in. (82.5x 57mm) of content with crop
marks positioned around a 3x2in. (76x50mm) area. This is normally only used with Step
and Repeat (Auto) and Step and Repeat (Fixed)

¢ (Crop Size
% 4
4 ¢
¢ Yoe e

Crop Size defines the size of the content to extract from the middle of the input page and is
independent of the use of crop marks. When the document size is smaller than the page
size specified by the application when printing, Crop Size allows you to extract the correct
content. For example, if you print a 3x5in. (76x127mm) document from InDesign, you
can specify to print it on Letter paper. You can use the Crop Size to select only the 3x5in.
(76x127mm) content.
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Setting application registration marks

Do not use application crop marks if you are using any setting other than Step and Repeat

(Auto) or Step and Repeat (Fixed).

For Step and Repeat (Auto) and Step and Repeat (Fixed), you can use either your application
registration marks or the Splash Server crop marks. Your application may provide a greater
selection of crop and registration marks than are available on the Splash Server. If you use
your application registration marks, you need to add to the page size or crop size to allow
enough space for the marks to print. Do not set both the application registration marks and
Splash Server crop marks at the same time. Using both will produce a set of duplicate and
overlapping marks that may be confusing.

For more information about imposition and other print options, see the Printing Guide.

Color management tools

The EFI Splash RPX-iii provides advanced color management tools. For more information
about the following features, see the Color Guide:

*  Color Cal offers a set of calibration tools for the digital press.

* Spot Color Editor allows you to add and delete spot colors, as well as change the value
output for any particular spot color.

* ColorTuner and ColorTweak allow you to edit the output color of RIPped pages before
printing all copies of the job.

* Profiles provides profiles and options for handling profiles.
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HOT FOLDERS AND VIRTUAL PRINTERS

You can print to the EFI Splash RPX-iii from the EFI Splash RPX-iii server computer or from
any client workstation with an AppleTalk or TCP/IP network connection.

This chapter describes the following ways of sending files to the EFI Splash RPX-iii:
* Drop-print to the EFI Splash RPX-iii Drop Folder.

* Drop-print to a EFI Splash RPX-iii Hot Folder.

e Print to a EFI Splash RPX-iii Virtual Printer.

* Drop-print to the EFI Splash RPX-iii GA File Converter Drop Folder.

This chapter also describes using the GA File Converter to convert certain graphic file formats
to PostScript or EPS and submit the converted jobs for processing through a Hot Folder.

You can also set up the EFI Splash RPX-iii as a printer on a client and use the EFI
Splash RPX-iii printer files to set print options. For more information, see the Printing Guide.

Supported file formats

The EFI Splash RPX-iii prints Acrobat PDE TIFE 1-bit TIFE EPS, TIFF/IT, PDF-X1/a,
CT/NLW, PSD, DCS 2.0, JPEG, Export PostScript, PDF2GO, and PostScript Level 1, 2,
and 3 files. The EFI Splash RPX-iii supports the importing of these data file formats.

Direct processing of PostScript, PDF, TIFE EPS, JPEG, and DCS 2.0 files is supported. The
TIFF/IT, PDF-X1/a, CT/NLW, Export PS, PDF2GO, and PSD formats are processed after
conversion by the GA File Converter that starts when the EFI Splash RPX-iii is started.

Note: The GA File Converter must be enabled in Splash Server>Preferences> Server.
For more information about setting preferences, see the Configuration Guide.

Supported Graphic file formats are EPS, Monochrome EPS, DuoTone EPS, TriTone EPS,
QuadTone EPS, RGB EPS, Index EPS, LAB EPS, CMYK EPS, Grayscale EPS, Black and
White EPS, TIFE Black and White TIFE, RGB TIFE Index TIFE Grayscale TIFFE and
CMYK TIFE
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Drop-printing using Drop Folders

Use drop-printing to print PostScript files, as opposed to using a PostScript file download
utility. The following Drop Folder options allow you to drop-print files.

NoTE: If a spooled file is not located on the EFI Splash RPX-iii hard disk, the EFI
Splash RPX-iii cannot print it. Copy the original file to the hard disk.

* Drop Folder handles direct processing of PostScript, PDF, TIFE EPS, JPEG, and DCS 2.0
files as they are sent or dragged to the Drop Folder. You can also print PDF files that are
password-protected in Adobe Acrobat. To do so, type a password in the PDF Password
field of the Edit Doc Info pane in the Job Options dialog box.

* Hot Folders allows you to create a particular set of pre-selected print options that are
applied to every file that is submitted to that Hot Folder. You can create multiple hot
folders and submit any PostScript, TIFE EPS, JPEG, PDE or DCS 2.0 file to them.

Create and delete Hot Folders by choosing Hot Folders from the Server menu. For more
information, see page 67. Any number of Hot Folders can be created with no limitation
other than available hard disk space. If file sharing is enabled, folders are automatically
shared when created.

Hot Folders co-exist with the Drop Folder. Drop Folder ensures compatibility for previous
releases and allows you to avoid forcing a set of job options on dropped jobs. Windows and
Mac OS download applications for the Drop Folder are automatically created when you start
the EFI Splash RPX-iii.

* GA File Converter Drop Folder supports direct processing of TIFF/IT, CT/NLW, PDF2GO,
Export PS, and PSD files sent to the GA File Converter Drop Folder. TIFF/IT files version
P1 and P1 8.8 are supported, assuming all three forks of the file (FB, CT, and LW) are
provided. The three forks can be provided in any order. By default, the output PostScript
file is placed in the Drop Folder for processing. Besides the Drop Folder, the GA File
Converter receives input from Hot Folders in the GA file Converter Hot Folders folder
and automatically outputs to the matching folder in Hot Folders.

& TIFF/IT, CT/NLW, PSD, or PDF-X1/a files may produce processing errors if they are
dragged to the EFI Splash RPX-iii queues or placed in the Drop Folder.

Note: All files copied to the Drop Folder are copied to the EFI Splash RPX-iii hard disk.

If you drop-print a PostScript file that was created with the EFI Splash RPX-iii application,
the EFI Splash RPX-iii uses the print options selected at the printer driver for the job. If the
PostScript file was not created with EFI Splash RPX-iii, the EFI Splash RPX-iii applies default
print options. To apply specific options to all jobs, create a Hot Folder (see “Hot Folders” on
page 67).
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Printing to Drop Folders

A Drop Folder is set up in the EFI Splash RPX-iii server Public folder when the EFI
Splash RPX-iii Server Software is installed. When the EFI Splash RPX-iii is running, you can

print to the Drop Folder over the network. The following procedures also apply for printing
to the GA File Converter Drop Folder.

For printing to a Hot Folder, see page 70.

To ACCESS A DRoP FOLDER FROM A WINDOWS COMPUTER

1
2

Click to Start and choose Run.

In the Open field, type two backslashes and the IP address of the EFI Splash RPX-iii, and then
click OK.

For example: \\10.10.257.1
The contents of the EFI Splash RPX-iii Public folder are displayed.

Drag and drop the files that you want printed to the Drop Folder or the GA File Converter
Drop Folder.

For convenience, create a shortcut to any Drop Folder that you print to regularly and place it
on the Windows desktop.

To ACCESS A DROP FOLDER FROM A MAC OS COMPUTER

1
2
3

Choose Connect to Server from the Finder's Go menu.
In the Server address field, type the EFI Splash RPX-iii IP address.
Click Connect and log on as Guest.

Select the Splash volume from the list of volumes on the EFI Splash RPX-iii server computer
and click OK.

Drag and drop the files that you want printed to the Drop Folder or GA File Converter Drop
Folder.

For convenience, make an alias of any Drop Folder that you use regularly, and place it on the

Mac OS desktop.
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Hot Folders

Hot Folders is a utility that allows you to store and reuse frequently used print options when
printing PostScript and PDF files on the EFI Splash RPX-iii. With Hot Folders, you can do
the following:

* Create special folders (Hot Folders) that assign specific print settings and print queues
to jobs.

* Print jobs to the EFI Splash RPX-iii by dragging and dropping them onto hot folders at
the EFI Splash RPX-iii server computer or from your desktop via File Sharing.

Hot Folders allows you to create multiple drop folders, each with an assigned set of print
options that are applied to all jobs placed in the folder. This allows you to control print

options and process a series of jobs with common printer driver options.

For any job placed in a Hot Folder, the options associated with the Hot Folder override any
options included in the job. A job created with the EFI Splash RPX-iii printer driver might

specify Duplex, Long Edge Bind, but if it is dropped into a folder for which Duplex is set to
None, the job does not print as Duplex.

Creating Hot Folders

Hot Folders are created in Home/Public/Hot Folders and Home/Public/GA File Converter
Hot Folders where Home is the current user's home directory. Folders may be shared via
AppleTalk for Mac OS clients and via SMB for Windows clients. Hot Folders do not replace
existing drop folders.

To cREATE HoT FOLDERS

1 Choose Login from the Server menu, type the Administrator password, and then click OK.

2 Choose Hot Folders from the Server menu.

000 Hot Folders

Drag jobs to these folders:

[ test

=g =

{8 Click the lock to make changes.

3 Click the lock icon to make changes.
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4 Click the “+"” to add a Hot Folder.

untitled
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) selected O odd

1- [_| Force Paper Size

example: 3, 5, 10-20, 25- Paper: [ Letter LEF —

Orientation:  Automatic
Scaling: Mone
Percentage: 100

Position: | Center

5 Specify print options on each tab, and then click OK.
6 Enter a name for the Hot Folder.

This is the name that the client selects at the client workstation.

7 Click OK.

Managing Hot Folders

The following options allow you to modify Hot Folders:

Edit allows you to edit the printer driver options of existing Hot Folders.
Rename allows you to change the name of a Hot Folder.

Delete allows you to select individual Hot Folders and delete them.

To ep1t HOT FOLDERS
1 Choose Login from the Server menu, type the Administrator password, and then click OK.
2 Choose Hot Folders from the Server menu.
3 Click the lock to make changes.
4 Double-click the Hot Folder that you want to edit from the list that appears.
The Job Options dialog box appears, allowing you to change the options.
5 Edit the print options for the Hot Folder, and then click OK.
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NoTE: If the options for a Hot Folder are being edited, the exact set of options that is applied
is dependent upon when the job finishes copying to the Hot Folder and when the editing is
completed. Jobs placed in a Hot Folder before editing starts use the old options. Jobs placed in
the folder after editing is completed use the new options. If a job is placed in the folder while
editing is in progress, an undefined set of options is attached.

To RENAME HOT FOLDERS

Choose Login from the Server menu, type the Administrator password, and then click OK.
Choose Hot Folders from the Server menu.

Click the lock to make changes.

Highlight and then click the Hot Folder that you want to rename.

Type a new name for the Hot Folder.

The maximum number of characters allowed in the Rename field is 255. If you have not
created any Hot Folders, the Rename option is unavailable.

NoTE: When you rename a Hot Folder, the old folder is automatically deleted and the new
one created.

To DELETE HOT FOLDERS

1
2
3

Choose Login from the Server menu, type the administrator password, and then click OK.
Choose Hot Folders from the Server menu.
Click the lock to make changes.

Highlight the Hot Folder that you want to delete and click “-".

NoTe: If you try to move a Hot Folder from the Public folder on the EFI Splash RPX-iii
server computer or drag it to the Trash icon, the server recreates the Hot Folder. As part of the
uninstall process of the EFI Splash RPX-iii Installer, Hot Folders are deleted.

Users at client workstations can view Hot Folders, but cannot make changes to the folder or
files. For more information about configuring the EFI Splash RPX-iii for file sharing, see the
Configuration Guide.
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Printing to Hot Folders

The following file formats are supported for Hot Folders:
* PostScript

* PDF

o TIFF

* EPS

* DCS2.0

* JPEG

* PSD

NoTe: The Hot Folders feature does not work with file types handled by the GA File
Converter. Any such files placed in a Hot Folder are moved to the Unprintable Files folder.

When a Hot Folder is created and published on the network, users at client workstations
connect to the EFI Splash RPX-iii and drag their file to the desired Hot Folder.

To ACCESS A HOT FOLDER ON A WINDOWS COMPUTER

1
2

Click Start and choose Run.

In the Open field, type two backslashes and the IP address of the EFI Splash RPX-iii and
click OK.

For example: \\10.10.257.1

The contents of the EFI Splash RPX-iii Public folder are displayed.
Double-click the Hot folders volume.

Drag and drop the files that you want printed to the desired Hot Folder.

For convenience, you can create a shortcut of any Hot Folders you print to regularly and place

it on the Windows desktop.

Access Hot Folders on a Mac OS computer in one of the following ways.

To ACCESS A HoT FOLDER FROM A MAC OS COMPUTER USING THE GO MENU

1
2
3

Choose Connect to Server from the Finder’'s Go menu.
In the Server address field, type the IP address of the EFI Splash RPX-iii.

Click Connect and log on as Guest.

4 Select the Splash Server volume from the list of volumes on the EFI Splash RPX-iii and

click OK.
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5 Double-click to open the Hot Folders folder.
6 Drag and drop the files you want printed to the desired Hot Folder.

For convenience, you can make an alias of any Hot Folders you use regularly and place it on
the Mac OS desktop. You can also run the server remotely and drag jobs to the Hot Folders
window.

To Access A HoT FOLDER FROM A MAC OS COMPUTER USING THE SERVER MENU
1 Start Splash Server.

2 Choose Hot Folders (or View Hot Folders) from the Server menu.

3 Drag jobs or folders to the Hot Folders window.

Sharing Hot Folders

You share Hot Folders over the network by enabling Personal File Sharing on the RPX-ii
Macintosh. Personal File Sharing is enabled by default when you install the EFI

Splash RPX-iii Server Software. The procedure below is only necessary if File Sharing has
been disabled.

To SHARE HOT FOLDERS
1 Choose System Preferences from the Apple menu.
2 Click Sharing in the Internet & Network section.
3 Click Personal File Sharing.

4 Quit System Preferences.

NoTe: Hot Folders are automatically shared via AppleTalk and SMB.

Using Hot Folders

After creating a Hot Folder, you can drag any PostScript, PDE, TIFE EPS, JPEG, PSD, or
DC 2.0 file to the Hot Folder.

TO DRAG FILES TO A HoT FOLDER WINDOW

e Select any job in the Finder and drag it to one of the Hot Folders in the list.

The Splash Server receives the job and applies the options specified for the Hot Folder.
A progress bar displays the progress for each file as it transfers or copies to the server.
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TO DRAG FOLDERS TO A HOT FOLDER WINDOW

e Select any folder in the Finder and drag it to one of the Hot Folders in the list.
The Splash Server receives the folder and applies the options specified for the Hot Folder.

NoTe: When you drag folders, the jobs in the folder are processed in alpha-numeric order. For
example, a folder containing jobs named Page001.pdf, Page002.pdf, Page003.pdf will process
the jobs in the same order: Page001.pdf, Page002.pdf, Page003.pdf.

To DRAG EXISTING JOBS OR FOLDERS T0 A HOT FOLDER WINDOW

¢ Select any job or folder in the Splash Server Hold or Error queue and drag to the icon of one of
the Hot Folders in the list.

The Splash Server applies the options specified for the Hot Folder.

The Splash Server leaves the job or folder in place, without creating a new copy of the job or

folder.



HoT FOLDERS AND VIRTUAL PRINTERS

Virtual Printers

The Virtual Printers feature allows you to set up individual print queues on the network, and
specify print options associated with a queue. Users can then print to these queues from
whatever applications they are using, and the print options are applied to the job.

To set up Virtual Printers, you must do the following:

* Create Virtual Printers on the EFI Splash RPX-iii.

* Install the EFI Splash RPX-iii printer driver on your client computer.
For more information, see the Printing Guide.

* Configure the Virtual Printer on your client computer.

Creating Virtual Printers

Once you have created Virtual Printers they are shared over the network.

To CREATE A VIRTUAL PRINTER

1 Choose Virtual Printers from the Server menu.

Virtual Printers. ]
Wirtual Printer
-
= TESTONE Name: 2-up collaterals
Register via:
™ AppleTalk
M LPR
Edit Options. ..

[+1=] o)

2 Click the Add button at the bottom of the window.

3 Type a name for the Virtual Printer in the Name field.
This is the name that is published over the network.

4 Choose the network protocol for publishing the Virtual Printer.
You can choose AppleTalk and LPR.



HoT FOLDERS AND VIRTUAL PRINTERS

5 Click Edit Options to configure print options for the Virtual Printer.
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6 Enter the settings for each tab.

7 To lock all the settings that you have specified in a tab, click the icon in the lower-left corner
of the dialog box, and select Lock all options from the drop-down menu.

#* [~
Lock all options
Unlock all options

When you lock an option or group of options, the settings override whatever is set at the
client in the print driver. Unlocked options are defaults but can be overridden by selections at
the print client.

For instance, you might want to define a particular booklet style for a Virtual printer. You
could then change color correction and quality settings, but the booklet format would be
locked for all jobs sent to that Virtual Printer.

In general, Virtual Printers will either lock a small number of critical options, such as color
correction or booklet, but allow the rest change, or lock almost all options and allow only a
select few, such as duplex, to change. You can use Lock all or Unlock all as shortcuts to
approximate to the settings you want before making individual changes.
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The locked settings are displayed with a lock icon next to them. You can also choose to unlock
all options.

2-UP marketing
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8 Click OK.
9 In the Virtual Printers dialog box, click OK.

The newly created Virtual Printer appears in the list.

To MODIFY VIRTUAL PRINTERS

1 Choose Virtual Printers from the Server menu.
Select the name of the Virtual Printer that you want to modify from the list.

To delete a Virtual Printer, click the Minus button at the bottom of the dialog box.

2
3
4 To change the name, modify the name in the Name field.
5 To edit print options, click Edit Options.

6

Click OK when finished.
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Setting up Virtual Printers on client computers

Once Virtual Printers have been created and published, they can be configured as printers on
client computers. Before setting up a Virtual Printer on a client computer, make sure you have
the following information:

* The DNS name and the IP address of the EFI Splash RPX-iii

¢ The name of the Virtual Printer

NoTe: You must install the EFI Splash RPX-iii printer driver on the client computer.

Virtual Printers can be set up on Windows 2000/XP/Server 2003/Vista and Mac OS X v10.2/
10.3/10.4/10.5 computers.

Setting up Virtual Printers on Windows computers

The following procedure describes setting up a Virtual Printer on Windows 2000/XP/Server
2003/Vista, with some differences in terminology and user interface.

To SET UP A VIRTUAL PRINTER ON A WINDOWS 2000/XP/SERVER 2003 /VISTA COMPUTER

1

Windows 2000: Click Start, choose Settings, and then choose Printers.

Windows XP: Click Start and choose Printers and Faxes.

Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click the Start button, choose Control Panel, and then double-click Printers.

Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Choose Add a printer and click Next.
Windows Vista: Click Add a printer.

Windows 2000/XP/Server 2003: Specify printing using a Local printer, clear the
“Automatically detect and install my Plug and Play printer” option, and then click Next.
Windows Vista: Select Add a local printer.

Click Create a new port, select Standard TCP/IP Port, and then click Next.
The Add Standard TCP/IP Printer Port Wizard dialog box appears.

Click Next in the Welcome window.

In the Add Port window, enter the following information:

* In the Printer Name or IP Address fields, type the IP address of the EFI Splash RPX-iii.

*  You can type the Virtual Printer name in the Port Name field, but it is not required.

NoTEe: Virtual Printer names are case-sensitive, and must be typed exactly.
Click Next.

In the Additional Port Information Required window, select Custom and click Settings.
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In the Port Settings window, click LPR for Protocol, type the Virtual Printer name in the
queue name field, and then click OK.

Click Next, and then click Finish to exit the Printer Port Wizard.
Select the EFI Splash RPX-iii from the list of manufacturers and printers.

If you have not installed the printer driver previously, follow the instructions for installing a
printer driver detailed in the Printing Guide.

Click Next.
In the Printer Name field, type the Virtual Printer name.

Choose whether to designate this printer as the default printer, share it, and print a
Test Page.

Click Next in each window.
Click Finish.
You can now print to the newly configured Virtual Printer using the specific job options.

You can also set up a Virtual Printer using Point and Print.

To SET UP A VIRTUAL PRINTER ON A WINDOWS COMPUTER USING POINT AND PRINT

1
2
3

Click Start and choose Run.
Type the EFI Splash RPX-iii IP address, with two backslashes before the IP address.
Double-click the icon for the Virtual Printer that you want to use.

You can now print to the Virtual Printer using the specific Virtual Printer option overrides.
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Setting up Virtual Printers on Mac 0S X v10.5 computers

Set up Virtual Printers on Mac OS X v10.5 computers in any of the following ways:
¢ Default browser (page 78)

* LPD connection (page 79)

* AppleTalk (page 80)

To SET UP A VIRTUAL PRINTER ON A MAC OS v10.5 COMPUTER USING DEFAULT BROWSER

1
2
3

Choose File > Print in your application.
Choose Add Printer from the Printer menu.
Select Default.

The name appears in the Name field, and the appropriate PPD file for the EFI Splash RPX-iii
is automatically selected. If it is not selected, proceed to step 4.

:Klnd |

Splash Kiosk Printer @ Splash Server’'s Computer Bonjour Shared -
Splash RPX-ii 7-16-07 @ Splash Server's Computer Bonjour Shared
Splash Server Bonjour
Splash Serverduplex AppleTalk m
Splash Server:duplex Bonjour ""
Splash Server.duplex @ Splash Server's Computer Bonjour Shared 3
Splash Server:splash @ Splash Server's Computer Bonjour Shared

n gy : M

Name: Splash Server

Location: US CA 303 Tech Pubs

Print Using: | Splash RPX-iii Xerox 700 4

Add

Choose Select a driver to use from the Print Using menu.
Type “splash” in the text filter (to narrow the search).
Select the Splash RPX-iii Xerox 700 or Splash RPX-iii Xerox 700 SA printer driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
with SA (for Secure Access).

Click Add.
Configure the installable options and click Continue.
The Virtual Printer appears in the list of printers.

You can now print to the newly configured Virtual Printer using the specific job options.
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To SET UP A VIRTUAL PRINTER ON A MAC OS v10.5 COMPUTER USING THE LPD CONNECTION

1 Choose File > Print in your application.
2 Choose Add Printer from the Printer menu.

3 Select IP.

The name appears in the Name field, and the appropriate PPD file for the EFI Splash RPX-iii
is automatically selected. If it is not selected, proceed to step 4.

= =
| T . i
— . —
Sea Q0 = =
Default  Fax IP Windows Bluetooth AppleTalk More Printers Search
Protocol: [ Line Printer Daemon - LPD H
Address: |10.16.225.108 -]
Valid and complete address.
Queue: |Dup|ex brochure |L]
Leave blank for default queue.
Name: 10.16.225.108
Location:
Print Using: [ Select a driver to use.. B
(Q spl D)
Splash RPX-iii Xerox 700
Splash RPX-iii Xerox 700 SA
Add

4 Choose Select a driver to use from the Print Using menu.
5 Type “splash” in the text filter (to narrow the search).
6 Select the Splash RPX-iii Xerox 700 or Splash RPX-iii Xerox 700 SA printer driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
with SA (for Secure Access).

7 Click Add.
8 Configure the installable options and click Continue.
The Virtual Printer appears in the list of printers.

You can now print to the newly configured Virtual Printer using the specific job options.
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To SET UP A VIRTUAL PRINTER ON A MAC OS v10.5 COMPUTER USING APPLETALK

1 Choose File > Print in your application.
2 Choose Add Printer from the Printer menu.
3 Select AppleTalk.

4 Choose the AppleTalk zone and select Splash Server.

The name of the server appears in the Name field, and the appropriate PPD file for the EFI
Splash RPX-iii is automatically selected.

US CA 303 QA Transit I 7 HP Laserjet 8000 Series &

US CA 303 Sales-Marketing * | Kenzanldt_Direct

US CA 303 Splash * | Kenzanldt_Hold

US CA 303 Tech Pubs P Kenzanldt_Print

US CA 303 Tech Pubs Lab1l | Lupin3dt_Direct

US CA 303 Tech Support Labl ~ * (1 Lupin3dt_Hald

US CA 303 Tech Support Lab2 = Lupin3dt_Print

US CA 303 Tech Support Lab3 &R splash server
US CA 303 Technical Suppart " | ¥ Splash Server duplex v

Character Set: Western (Mac OS Roman)  + |

Name: Splash Server

Location: US CA 303 Tech Pubs
Print Using: | Splash RPX-iii Xerox 700 )

Add

5 Click Add.
6 Configure the installable options and click Continue.
The Virtual Printer appears in the list of printers.

You can now print to the newly configured Virtual Printer using the specific job options.
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Setting up Virtual Printers on Mac 0S X v10.4 computers

Set up Virtual Printers on Mac OS X v10.4 computers in any of the following ways:
¢ Default browser (page 81)

e LPD connection (page 82)

* AppleTalk (page 83)

To SET UP A VIRTUAL PRINTER ON A MAC OS v10.4 COMPUTER USING DEFAULT BROWSER
1 From the Finder, choose Go>Utilities>Printer Setup Utility.
2 In the Printer List window, click Add.
3 Select Default Browser.
4 Select the Splash Server: <Virtual Printer name> with a Bonjour connection.

The name appears in the Name field, and the appropriate PPD file for the EFI Splash RPX-iii
is automatically selected. If it is not selected, proceed to step 5.

eOe Printer Browser =
. 2 Q
=
Default Browser IP Printer Search
Pri N - I Connection
Splash Server Bonjour r
Splash Server:SplashLTR AppleTalk
Splash Server.SplashLTR Bonjour
Splash Server. TabloidSaddle AppleTalk
Splash Server. TabloidSaddle Bonjour
Splash Server TrifoldBrochure AppleTalk b
Splash Server: TrifoldBrochure Bonjour ud
Titanic AnnleTalk b

Name: Splash Server

Location: Splash Server

Print Using: | Splash RPX-iii Xerox 700 B

@ ( More Printers. .. ) ( Add )

5 Choose Splash from the Print Using menu, and then select the EFI Splash RPX-iii printer
driver.

6 Click Add.
7 Configure the installable options.
The Virtual Printer appears in the list of printers.

You can now print to the newly configured Virtual Printer using the specific job options.
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To SET UP A VIRTUAL PRINTER ON A MAC OS v10.4 COMPUTER USING THE LPD CONNECTION

1
2
3

From the Finder, choose Go> Utilities>Printer Setup Utility.

In the Printer List window, click Add.

Click the IP Printer icon.

The IP Printer pane appears.

Choose Line Printer Daemon - LPD from the Protocol menu.

Type the IP address of the EFI Splash RPX-iii.

The IP address appears in the Name field as you type in the Address field.

Type the Virtual Printer name in the Queue field.

8ene Printer Browser =)
oY )
= b=
Default Browser IP Printer Search
Protocol: | Line Printer Daemon - LPD |+]
Address: | 10.10.96.94 -]

Valid and complete address.

Queue: FoldedBrochure H

Leave blank for default queue.

Name: 10.10.96.94

Location:

Print Using:  Splash |+]

Model a

Splash RPX-iii Xerox 700
Splash RPX-iii Xerox 700 SA

@ ( More Printers. .. ) ( Add )

7 Choose Splash from the Print Using menu, and then select the Splash RPX-iii Xerox 700 or

Splash RPX-iii Xerox 700 SA printer driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
with “SA” for Secure Access printing.

Click Add.
Configure the installable options.
The Virtual Printer appears in the list of printers.

You can now print to the newly configured Virtual Printer using the specific job options.
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To SET UP A VIRTUAL PRINTER ON A MAC OS v10.4 COMPUTER USING APPLETALK
1 From the Finder, choose Go > Utilities > Printer Setup Utility.
2 In the Printer List window, click Add.

3 Click the Default Browser or IP Printer icon.
NoTEe: Use this procedure if the EFI Splash RPX-iii is in a different AppleTalk zone than your

computer. If it is in the same zone, the EFI Splash RPX-iii is displayed as a default browser.
Follow the procedure on page 81.

HP Laserjet 8150 Series {(434BCC)

o6 Printer Browser (=)
S =
Default Browser IP Printer Search
Pri N a ! Connection
Archipelago AppleTalk
Bailey AppleTalk
Barnum AppleTalk
HP Laserjet 55i AppleTalk
HP Laserjet 8000 Series AppleTalk

Bonjour

aln(

Name:

Location:

Print Using: Please select a driver or printer model

@ ( More Printers... )

4 Click More Printers.

A dialog box appears, listing other connections.
5 Choose AppleTalk from the connection menu.

The AppleTalk pane appears.
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HoT FOLDERS AND VIRTUAL PRINTERS

Choose the AppleTalk zone for the EFI Splash RPX-iii.

The AppleTalk printers in the specified zone appear in the list. The Virtual Printers that are
configured at the EFI Splash RPX-iii also appear in the list.

NoTe: The names of the Virtual Printers appear as <Splash Server: Virtual Printer name> in
the Name list.

[ AppleTalk B

(UscCA303 TechPubs  [3)

| & Type
A
-~
Splash Server PostScript Printer
Splash Server:SplashLTR PostScript Printer
Splash Server:TabloidSaddle PostScript Printer m
Splash Server: TrifoldBrochure PostScript Printer &
Titanic PostScript Printer v
[ Character Set: Western (Mac) -
Printer Model: | Auto Select )—:]
adi )

Select the Splash Server: <Virtual Printer name> name in the Name list.

Choose Splash from the Printer Model menu, and then select the EFI Splash RPX-iii printer
driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
for Secure Access printing.

Click Add.
Configure the installable options.
The Virtual Printer appears in the printer list.

You can now print to the newly configured Virtual Printer using the specific job options.
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Setting up Virtual Printers on Mac 0S X v10.3 and earlier computers

Set up Virtual Printers on Mac OS X v10.3 and earlier computers in any of the following
ways:

* AppleTalk (page 85)
* LPD/LPR connection (page 86)

* Rendezvous (page 87)

To SET UP A VIRTUAL PRINTER ON MAC OS v10.3 AND EARLIER USING APPLETALK

Choose Utilities from the Finder’'s Go menu.

NoTE: If you are using Mac OS X v10.2.x, select Applications > Utilities to access the Print
Center.

Start Printer Setup Utility or Print Center.

Click Add.

Choose AppleTalk from the connection menu.

Choose the AppleTalk zone for the EFI Splash RPX-iii.

The Virtual Printers that are configured at the EFI Splash RPX-iii appear in the list.

NoTe: The names of the Virtual Printers appear as <Splash Server: Virtual Printer name> in
the Name list.

Select the Splash Server: <Virtual Printer name> name in the Name list.

AppleTalk )
US CA 303 Tech Pubs )
" Name 7 —

Splash Server PostScript Printer

Splash Server:SplashLTR
Splash Server:TabloidSaddle
Splash Server: TrifoldBrochure

PostScript Printer

PostScript Printer

PostScript Printer m
i
v

Titanic
[ Character Set: Western (Mac) -

PostScript Printer

Printer Model: | Auto Select

b

(Canee) @)

Choose Splash from the Printer Model menu, and then select the EFI Splash RPX-iii printer
driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
for Secure Access printing.

Click Add.
Configure the installable options.

You can now print to the newly configured Virtual Printer using its specific job options.
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To SET UP A VIRTUAL PRINTER ON MAC OS v10.3 AND EARLIER USING LPD/LPR

10

Choose Utilities from the Finder’s Go menu.

NoTE: If you are using Mac OS X v10.2.x, choose Applications > Utilities to access the Print
Center.

Start Printer Setup Utility or Print Center.

Click Add.

Choose IP Printing from the connection menu.

Choose LPD/LPR from the Printer Type menu.

Type the EFI Splash RPX-iii IP address in the Printer Address field.

Type the Virtual Printer name in the Queue Name field.

“ip Printing |+j
Printer Type: | LPD/LPR 9
Printer Address: 10.10.83.6 8
Complete and walid address
Queue Name: TrifoldBrochure 8
Leave blank for default queus
Printer Model: | Generic |+i
)

Choose Splash from the Printer Model menu, and then select the EFI Splash RPX-iii printer
driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
for Secure Access printing.

Click Add.
Configure the installable options.
The Virtual Printer appears in the printer list.

You can now print to the newly configured Virtual Printer using its specific job options.
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To SET UP A VIRTUAL PRINTER ON MAC OS v10.3 AND EARLIER USING RENDEZVOUS

1

In the Finder, choose Utilities from the Go menu.

NoTE: If you are using Mac OS X v10.2.x, choose Applications > Utilities to access the Print
Center.

Start Printer Setup Utility or Print Center.
Click Add.

Select Rendezvous from the connection list.

"Rendezvous |+]

HP Lazer]et 5150 Series {(434BCC)
Splazh Se:Tabloid SWOP Hot Folder
Splazh Server

Splazh ServerTrifold Brochure

Location:  Splash Server:Trifold Brochure

Printer Model: | Generic |+]

CCancel) (@Ad)

Select the Splash Server: <Virtual Printer name> printer name.

Choose Splash from the Printer Model menu, and then select the EFI Splash RPX-iii printer
driver.

If you have configured Secure Access printing at the EFI Splash RPX-iii, select the PPD file
for Secure Access printing.

Click Add.
Configure the installable options.
The Virtual Printer appears in the printer list.

You can now print to the newly configured Virtual Printer using its specific job options.
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GA File Converter

The GA File Converter allows you to print the most popular pre-press file formats without
requiring the application in which they were created. Pre-press format files are created by
imagesetters and pre-press proofing systems. Print these files on the EFI Splash RPX-iii for
proofing and pre-flight purposes by converting them to PS or EPS files. The GA File
Converter must be used with Hot Folders.

The following formats can be converted by the GA File Converter:
e TIFF-IT

* CT/ILW

* CT/NLW

* PDF2GO

* ExportPS

* PDF-Xl/a

NoTe: When dealing with multi-file formats (TIFF-IT, CT/NLW), it is best to put all of the
component files in a folder and drop the folder into the input folder.

To ENABLE THE GA FILE CONVERTER

1 Open the Splash Server Preferences dialog box.
2 Click GA File Converter on the Server tab, and then click OK.
The GA File Converter icon appears in the EFI Splash RPX-iii server Dock.

For more information about setting EFI Splash RPX-iii server preferences, see

the Configuration Guide.
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To CONFIGURE THE GA FILE CONVERTER

NoTEe: Before configuring the GA File Converter, create the Hot Folder that you want to use
for the file conversion. To create a Hot Folder, see page 67.

1 Click the GA File Converter icon in the EFI Splash RPX-iii server Dock.

1 GA File Converter icon

The GA File Converter dialog box appears.

080 GA File Converter
Conversion Queue Current File Image
File Name:
Status: Idle
Percent:
[ Cancel

2 Choose Preferences from the GA File Converter menu.

GA File Converter Preferences

Conversion Options 1

—
Resolution
200 DPI () 400 DPI () 600 DPI
Anti-Aliasing
() Bilinear @ Nearest Neighbor (Faster)

o)
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3 On the Conversion Options tab, specify the settings that you want, and then click OK.
The Conversion settings are as follows:
Resolution: The default is 200 dpi. Increase the resolution for printing smoother line art.
Anti-aliasing: The default is Nearest Neighbor. For highest quality output, select Bi-linear.

The default settings are designed to provide the fastest printing results possible. Changing
these settings can result in increased RIPping and printing times. We recommend that you
only change these settings if you are printing line art that requires high-resolution printing.

You can now print to the newly created GA File Converter Hot Folder.

When a Hot Folder is created on the Splash Server, a Hot Folder of the same name is placed
in Home:Public: GA File Converter Hot Folders. This is the input folder to use for the GA
File Converter.
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EFI SPLASH RPX-iii PRODUCTION FEATURES

The EFI Splash RPX-iii offers features that are particularly useful in a production printing
environment. The production printing features for the EFI Splash RPX-iii include the
following:

¢ Set Builder

¢ Mixed Media
e Schedule

¢ Job Error

* Resume Printing

Set Builder

The Set Builder feature allows you to gather a series of documents and collate them as a single
document set. You can then print the set using a standard set of finishing options, such as
Copies, Collate, Staple, Rotate, and Duplex. Set Builder combines documents from multiple
applications and platforms, freeing you from piecing documents together into a single
application at the client workstation.

The Set Builder user interface is list-based, allowing you to add individual jobs to a document
set and arrange the order of the jobs within the document.

The Set Builder main window displays available jobs in the Hold and Error queues. For jobs
in the Available jobs list, you have the option to Add, Duplicate, or Edit the print job options.

The options in the Document Set Options dialog box allow you to set Job Handling options
globally (for example, Staple, Duplex, Insert Blank Pages), overriding the options for each
individual job in the set. Click Document Info to edit information such as the Document
Title, User ID, Password, and Account.
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Printing a document set with Set Builder

The following procedure describes how to create and print a document set with Set Builder.

TO CREATE A DOCUMENT SET WITH SET BUILDER

1 Choose Set Builder > New Set from the File menu or click the Set Builder icon in the toolbar.

The Set Builder dialog box appears.

0606 Untitled
Available Jobs: Preview:
People.tif
Olympics.tif

OnePageTest.pdf
Extra.pdf
People.tif

Olympics.tf

€ Add 3 € Edit... 3

Document Set Jobs:

Olympics.tif

Cmom) (G @06

4

2 Select a job from the Available Jobs list and click Add.
The job moves to the Document Set Jobs list.

NoTE: When you select a job in the Document Set Jobs list, the Add button changes to
Remove, allowing you to delete the job.

3 Select additional jobs for the set and reorder the jobs by dragging them up or down in the
Document Set Jobs list.

4 Click Options.

The Document Set Options dialog box appears, allowing you to select the finishing options
for this document set.
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Click Page to set the number of copies and job handling options.

Document Set Options

la @ - @

Page Imposition Output Info

Copies: 1

_Job Handling

@ Collate
] Rotate Pages

Duplex: "No Duplex

ar

!m;er( Blank Pages

Click Imposition to print document set as a booklet.

Document Set Options

& 0 o

Page it Output  Infa
# Imposition Presets... -
Type
Type: | Saddle-Stitch :
Section Size: [ All B
Cover: [ None =)
) Duplex
Media Type: | Docu . 3! N/A

Tray: [ Document Default

Output
Output Paper Size: | Automatic 2]
1 Scale to Fit
CropMarks: (o 1)

e

For information about Imposition and booklet printing, see page 53.
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7 Click Output to set output destination tray and finishing options.

Document Set Options

lg T [ @

Page Imposition Output Info

Staple/Punch

Staple: None

Finishing:
(®) None
() staple/Punch

Punch:  None
() single Page Folding

©) Booklet Position: | Left
[ Z-Fold Half Sheet
‘Qutput Destination: Single Page Folding
(ool 77)
¥ Offser Mode Style: | Single Fold AW
Booklet
Image Shift...

i bl

Fold !

Fold and Staple 5\‘

Fasten Mode:

8 C(lick Info to edit the Document and User ID fields.

Document Set Options

o 01 (=@

Page Imposition Output = Info

Document: | Untitled

Filename: Spool 00000051

User: Document Set

Password:

Account:

Comment:

NoTE: If Secure Access is selected at the server, you must type information in the Password
and Account fields. When the document set is printed, this information is applied to every
job that is part of the set.

9 Click OK.

Your document set now appears in the Hold queue. When you move it to the Active queue to
print it, its status changes to Assembling. The components of the document set RIP and save
image files, but do not print. When the components have all RIPped, the document set status
changes to Printing, and the set begins to print.
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To EDIT A DOCUMENT SET

1 Choose Set Builder > Open Set from the File menu.
2 Select the document set in the list and click Open.
The main Set Builder window opens.
3 Click Options and change job settings as desired.
NOTE: You can also edit a Document Set by double-clicking the set in the Hold queue.

4 Click OK.

Setting finishing options

Certain finishing options, such as the number of copies printed and the output tray used, are
applied to the entire document set. These finishing options override the equivalent settings in
the Edit Job dialog box for all jobs that are part of the document set, and include the
following:

* Copies

* Duplex

* Insert Blank Pages

e Staple/Punch Finishing Options

* Imposition Options

* Booklet Finishing Options

* Single Page Folding Finishing Options
* Collate

* Rotate Pages

* Offset Mode

*  Output Destination
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Managing Set Builder jobs
In the Set Builder dialog box, you can select options to manage the sets that you create.
* Remove removes a job from the list of jobs in the Document Set Jobs list.

* Duplicate duplicates a selected job in the list of Available Jobs. After clicking Duplicate, if
you want to change options for the new job, you must select the duplicated job and click
Edit to open the Job Options dialog box. Click Edit Doc Info in the Info pane of the Job
Options dialog box to change the Name, User ID, Password, Account, or Comment fields.

* Edit opens the Job Options dialog box. Edit the job print options here, or double-click the
job in the Available Jobs list.

* Preview displays the previews for any selected job in the Available Jobs or Document Set
Jobs lists.

Duplex and odd-length jobs

When you select Duplex printing for a document set, the total number of pages in any
component job in the document set is “padded” so it has an even number of images (sides),
if the Insert Blank Pages option is enabled.

For example, a document set composed of a five-page job, a four-page job, and a three-page
job, prints a total of seven sheets, with the back side of the third and seventh sheet left blank.
With the Insert Blank Pages option disabled, the document prints a total of six sheets.

Previews

The Preview window only previews jobs that have been RIPped. The arrow keys move from
page to page within a job, but do not cross from job to job, even in the Document Set Jobs
list. To see the entire preview of a document set, select the first job in the Document Set Jobs
list and click the right arrow. Scroll through the job undil the page number stops
incrementing. Select a second job and repeat until you have scrolled through the entire
document set.

Errors in Set Builder document sets

If an error occurs in any component of a document set, the entire document set fails to print.
To reprint the document set, correct the error and re-release the document set. Only the jobs
that previously caused the error re-RID
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Mixed Media

Mixed Media allows you to print a single job on different types of paper and to different
paper trays.

To use MIXED MEDIA

1 Select a job in the Hold queue and choose Mixed Media from the Jobs menu or the Tray tab of
the Job Settings dialog box.

080 Mixed Media - eimo.pdf

Mixed Media Types

0 0O 4 O 3 F 9N

Chapter  Page Range Blank Sheet TabPage  Tablnsert  TabShift  FrontCover Back Cover

Mixed Media Settings

Type Page Range  Duplex Media Type Paper Source
|o) Document Default - No Duplex Tray Default Automatic
No Item Selected
Delete Setting ) Document Paper Size: Unknown
(ﬁﬂib Setup... Pages In Document: 16

(Cance) @06
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2 To specify media for a particular item, drag the icon into the Mixed Media Settings list and
select the settings.

You can specify media for the following: Chapter, Page Range, Blank Sheet, Tab Page,
Tab Insert, Tab Shift, Front Cover, and Back Cover.

068 o Mixed Media - eimo.pdf

Mixed Media Types

n9 3 4 1 07 F N

Chapter  Page Range Blank Sheet TabPage  Tabinsert ~ TabShift  Front Cover Back Cover

Chapter Settings

Mixed Media Settings

Type Page Range  Duplex Media Type Paper Source
3 L . g g = L p P Chapter Start Page:
[8) Document Default - No Duplex  Tray Default Automatic
' Front Cover 1 No Duplex  Tray Default Automatic 2
Chapter 1 2-0

( A chapter will always start on the
front side of a duplex sheet. )

Apply

Delete Setting Document Paper Size: Unknown
Tab Setup... Pages In Document: 16
o

When the icon for the item is selected, the available settings are displayed in the right pane
of the Mixed Media window. For a more detailed description of the available settings, see

“Mixed Media settings” on page 99.
3 Make changes and click Apply.
All of the settings are displayed in the Mixed Media Settings list.

Mixed Media - iMovieAtAGlance.pdf

Mixed Media Types

L/ T [ Ty B i | R B T |

Back Cover Settings

Chapter  PageRange  Blank/ TabPage Tablnsert TabShift Front Cover Back Cover
Int
nsehr:;!e Plex Mode:
= re)
Mixed Media Settings Print Back '
Type Page Range  Duplex Media Type Paper Source
[ Docur ault — Lon e Bil Uncoated (64-80 gsm) Tray § Duplex:
J* Front Cover 1 No Duplex  Uncoated (64-80 gsm) Tray 5 Long Edge Binding |
| Chapter 1 2-w
|| Blank 24 Uncoated (64-80 gsm) Tray 5 Media Type:
Back Cover - Long Edge Bit Uncoated (64-80 gsm) Tray 5
a o 2 . [ Uncoated +16a-80gsm &)
Tray:
"Tray 5 B
( Apply )
Delete Setting Document Paper Size: Letter LEF
Tab Setup... Pages In Document: 10
Ci

s |

4 Click OK to save and exit the Mixed Media window.
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Mixed Media settings

This section describes Mixed Media settings.

Chapter

Specify a page as the start of a chapter. Chapter starts must print on the front side of a duplex
page if the document or page range containing it is duplex. If required, a blank second side
is inserted automatically to make the chapter start on the front side of the duplex page.

In the Chapter Start Page field, type the page number on which you want chapters to start.
On client computers, you can enter more than one page number for the chapter starts.

Chapter Settings

Chapter Start Page:
B

( A chapter will always start on the
front side of a duplex sheet. )

{ Apply )




EFI SPLASH RPX-iii PRODUCTION FEATURES

Page Range

Specify a page range to print on a particular media type.

* Type the page number of the page range in the Page Range fields.
*  Choose Duplex or No Duplex.

* Choose a Media Type.

* Choose a Tray.

Page Range Settings

Page (Range):

2 - |2

Duplex:

[No Duplex

v

Media Type:

[Uncoated % ] [64-80 gsm 7 ]

Tray:
[ Tray 5

ar

Apply
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Blank/Interpose Sheet

Specify a blank sheet to be inserted before or after the selected page. The Interpose option

allows you to pull several sheets from the Interpose tray by specifying a number of sheets to
insert.

* Type a page number and choose Before page or After page.
* Choose a Media Type.

* Choose a Tray.

Blank Sheet Settings

Insert Blank Sheet:

" After page d‘ 7

Media Type:

[ Tray Default )-H
Tray:

" Automatic )-H

[ Apply )
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Tab Page
Specify a page of the document to be printed on the body of a tab sheet. Unlike Tab Shift,

when using Tab Page the page content does not need to be specially constructed or designed
to print on a tab. You can also add selected text and image on the tab.

NoTEe: Tab Page is not available from client computers.

* Click Tab Setup to set up the Tab Attributes that are applied to all the tabs used in the
document.

* In the Tab Setup dialog box, specify the number of tabs in a set, tab page size, tray, media
type, and whether to apply same text attributes for all tabs.

* In the Tab Setup dialog box, click Tab Attributes to specify rotation of the text on the tab,
alignment, font type, size, and color, and see a preview of how the text will appear on the

tab.

NoTe: For information about Tab Setup, see “Printing Tabs” on page 107.

* In the main Mixed Media window, with the Tab Page selected in the Mixed Media Types,

specify the page, the tab text, and a tab image. Click Tab Attributes to customize attributes
for the selected Tab Page.

Tab Page Settings

Tab Page:
2
Tab Text:
Tab Image:
—_—
Tab Attributes...

[ Apply




EFI SpLASH RPX-iii PRODUCTION FEATURES

Tab Insert

Specify a tab sheet to be inserted in a document and add the text and/or image to be printed
on the tab.

* Type a page number and choose After page or Before page.
e Type the tab text.
* Add a tab image (see the following section).

*  Specify Tab Attributes (see “Tab Attributes” on page 104).

Tab Insert Settings
Insert Tab:

" After page I:-j‘ 1
Tab Text:
Tab Image:

—

Tab Attributes...
Apply
Tab Image

To add a tab image, drag the image file from your desktop to the Tab Image well directly
above the Tab Attributes button (see page 104). Supported file types are PDE EPS, JPEG,
and TIFE

Any size image is accepted and is scaled to fit the roughly 1/4-inch by 1/2-inch area, if text is
typed in the Tab Text field. If the Tab Text field is blank, the image area expands to an area
1/4-inch high and as wide as the tab.

NoTE: Smaller images process more quickly. For quality results with the shortest processing
time, use a 300 dpi or higher image, designed to fit the available space.
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Tab Attributes

You can specify rotation, alignment, font, size, text, color, and an image in the Tab Attributes
dialog box. The following illustration shows a preview of the tab text as it has been specified

according to the displayed tab attributes. To select a color for the text, choose Custom Color
from the Color menu, and pick a color from a variety of palettes.

One of the palettes is a view of the image you have placed on the tab. Select a color directly
from the image to ensure a good match between the tab text color and the image.

Other palettes are standard CMYK controls and the Spot Color Table.

Rotation:

@ = e A
= < g
Tab Preview
Alignment:
(Left )
Font:
[ Arial Narrow |+]
Size:
(12 )
Color:
[ Custom Calor... 3]

Tab Text:

ANNIJALI CONFERENCE

Image:

Drag image on to image well to add
image to tab

( Cancel ) G—G!(—a




EFI SpLASH RPX-iii PRODUCTION FEATURES

Tab Shift

Specify an existing page of a document to be shifted so that part of the page prints on the tab
and the other part prints on the body of the tab sheet.

* Type a page number.

NoTe: No default Tab Attributes are specified for Tab Shift. The contents of the tab are
determined solely by the contents of the original document.

Tab Shift Settings

Page To Tab Shift:
4

Apply




EFI SpLASH RPX-iii PRODUCTION FEATURES

Front Cover and Back Cover

Specify the first page of the document as a front cover, and the back page as a back cover.

* Choose Plex Mode to specify which side of the covers get printed, Print Front, Print Back,
or Print Both.

If Print Both is selected, Long Edge Binding or Short Edge Binding must be chosen from
the Duplex menu.

* Choose a Media Type.

* Choose a Tray.

Front Cover Settings Back Cover Settings
Plex Mode: Plex Mode:

" print Front )+] Print Back }—-‘.—]
Duplex: Duplex:

No Duplex ) ' Long Edge Binding I—H
Media Type: Media Type:

Uncoated )+] 64-80 gsm |+] Uncoated H‘r] 64-80 gsm H—]

Tray: Tray:

[Tray s |+] Tray 5 |+]

( Apply ) Apply

NoTe: The EFI Splash RPX-iii constrains invalid combinations of Media Type and Duplex
settings. The client does not apply these constraints. If the EFI Splash RPX-iii receives a job
that specifies an invalid Duplex and Media Type combination, it changes the Duplex setting
to None and retains the selected Media Type.
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Printing Tabs

Print a tab job to the EFI Splash RPX-iii using the Send and Hold option, along with any
other desired options, such as number of copies.

You can initiate tab printing from the EFI Splash RPX-iii or from the Splash Server Remote 3.

To PRINT TABS
1 Select the job in the Hold queue.

2 Choose Mixed Media from the Jobs menu.
3 Click Tab Setup and define the attributes of the tabs used in the job, including
¢ Number of tabs in a set
* Tab page size
e Tray
* Media Type

¢ Default tab attributes

NoTe: To set default tab attributes, select Apply same text attributes for all tabs, and then click
Tab Attributes.

Tab Setup

Number of tabs in a set:

5 :
Tab page size:

Letter LEF )
Tray:

Tray 5 )+]
Media Type:

| Uncoated |+] 64-80 gsm )+]

] Apply same text attributes for all
tabs

Tab Attributes. ..

(Coneel) @06

4 Click OK.
5 In the main Mixed Media window, drag Tab Insert, Tab Page, or Tab Shift to the list.

6 Select the item for which you want to specify settings.
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Type the page number and specify the other settings.

For information about Tab Insert, see page 103.

For information about Tab Page, see page 102.

For information about Tab Shift, see page 105.

After specifying settings, click Apply to save changes.

Repeat steps 6 through 8 for all tabs in the job.

Click OK to close the Mixed Media dialog box.

Release the job from the Hold queue.

NoTE: If you choose Tab Stock 1 as the Media Type for tabs, you must use single reverse

collated tabs. If you choose Tab Stock 2 as the Media Type for tabs, you must use single
collated tabs.
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Schedule Job

Schedule Job allows you to set a time and date to print a job.

To SCHEDULE A J0B

1 Select a job in the Hold or Error queue and choose Schedule Job from the Jobs menu.

quick setup guide.dec

™ Schedule job

5/10/2006 [3) 7:00 PM 3]
Q00 May 2006
SM TWTF §

12 3 456
7 8 9plWi111213
14 15 16 17 18 19 20
21 22 23 24 25 26 27
2B 29 30 31

() o)

2 Select Schedule job and choose a date and time.
3 Click OK.

A clock icon appears in the Info-Detailed column next to the job name in the Hold queue.

Job Error

If a job in the Active queue cannot print due to the digital press status, an error message is
displayed and an alert sounded. The job is suspended and moved to the Error queue so that
the next job can print. You can specify how long an error message is displayed and can turn off
the sound alert in the Server tab of the Splash Server Preferences. For more information, see
the Configuration Guide.
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Restart Printing

Restart Printing reprints the job from the beginning, regardless of the error condition of any
previous print.

To RESTART A PRINT JOB

¢ Select your job and choose Restart Printing from the Jobs menu.

Resume Printing

Resume Printing allows you to resume printing a job that has been suspended and moved to
the Error queue. When you select Resume Printing, the job prints from the point at which it
left off. For a collated document, printing resumes at the start of the set.

To RESUME A PRINT JOB

¢ Select the suspended job in Error queue and choose Resume Printing from the Jobs menu; or

¢ Select the suspended job in the Error queue and drag it to the Active queue.
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SPLASH SERVER REMOTE 3

The Splash Server Remote 3 application allows you to view and manage the EFI

Splash RPX-iii from a remote Mac OS X workstation. It is intended as an administrative tool.
Most features are available when you log on with Administrator privileges. If you are not
logged on with Administrator privileges, you have limited access to some functions and jobs.
For information see “Splash Server Remote 3 functions” on page 114.

NoTEe: Splash Server Remote 3 is only supported on Mac OS X v10.4 or later.

For more information about installing Splash Server Remote 3 and connecting to a EFI
Splash RPX-iii, see Gerting Started.
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Using Splash Server Remote 3

Splash Server Remote 3 provides the same interface as that on the EFI Splash RPX-iii . It
makes most of the features of the EFI Splash RPX-iii available for remote administrators.

When Splash Server Remote 3 is running, you can switch the connection to a different EFI
Splash RPX-iii using the Connect to Server command in the Splash Server Remote menu.
The same choices for connections are available in the Connect to Server menu selection in the
Splash Server Remote interface.

To USE SPLASH SERVER REMOTE 3

1 Click the Splash Server Remote 3 icon on the Mac 0S X client computer desktop.

Splash Server Remote

2 Choose Connect to Server from the Splash Server Remote 3 menu.

Enter IP Address of Splash Server to connect to:

Rendezvous

Available Splash Servers
Splash Server

Manually enter Splash Server |P address:

10.10.83.28

( Cancel ) E—Eurmccl.—a
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3 Select the EFI Splash RPX-iii that you want to connect to from the list of Available Splash

Servers, or type the EFI Splash RPX-iii IP address in the IP address field, and then click
Connect.

You can view jobs as guest, or log on with Administrator privileges to perform administrative
functions.

NoTe: The following illustration shows the Splash Server Remote 3 application when you log
on with Administrator privileges.

o606 Splash Server
3 N o Splash RPX~iii
D bl | =il = e @ p
SetBuilder Color Profiles Color Tweak Mixed Media Schedule Preflight Stopped
Active Preview \ }
Status Document User |Copies
Pending Splash RPX-iii Startup Page.pdf Drop Folder 1=
Pending Splash RPX-iii Startup Page.pdf Drop Folder 1%
Pending IDFinstall.pdf Dropped File 1f;
Ppndine Solach ROV i Ctactin Baan adf Aean Eoldor .
y<Tr
Hold A (2 S O O O
DP700
1— Letter LEF 3 — Tabloid
2 — Letter LEF
=" —— —
Info Document User [size Pages |Spool T~ Online
SR ColorCal Target.ps admin 191 KB 1 3/19/0
BRI P iMovieAtAGlance.pdf Drapped File 2.1 MB 10 3/17/0
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cl Splash
Error \
Controller: DC-700-4A8CS0 (10.16.225.108)
Document User Completion Time | Error Message I~ Appleralk: Orline (Splash Server)
Splash RPX-ill Startup Page.pdf Drop Folder ~ 3/26/08 12:24 PM  No Uncoated (81-90 1P Printing: Online (10.10.83.24) .
Splash RPX-ill Startup Page.pdf Drop Folder  3/26/08 12:13 PM  No Uncoated (81-90 Last Calibrated: Not Calibrated (=]
Center Alignment Verification Page.pdf Drop Folder  3/19/08 6:03 PM  No Uncoated (81-90 Disk Space Used e—
unssa 16onvinn Damn mAf Menn Caldne 3 110/08 £:03 MM Kialincansn o1 i oiics
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Splash Server Remote 3 functions

You can access EFI Splash RPX-iii as a guest or administrator. The following table shows what
functions and settings of the EFI Splash RPX-iii are available remotely for administrator or

guest access, and what functions are unavailable under any circumstances.

Administrator functions

Guest functions

Functions not
available remotely

Change Preferences

Print Configuration Page
Create Document Sets
Start/Stop processing

Create Hot Folders

Create Virtual Printers
Change Secure Access settings
Create/delete Users
Create/delete Accounts
Change print Info settings
Change Screening Preferences
Change Color Profiles
Change Calibration Summary
Change Output Profiles
Delete Color Profiles

Edit Job Options

Delete Jobs

Schedule Jobs

Change/create Mixed Media
settings for jobs

Hold jobs

Remove a hold on jobs
Preflight jobs

Color Postflight jobs

Show Preflight for jobs

Restart processing a job
Resume processing a job

Apply defaults to a job

Edit the default settings for jobs
Clear Color Tuner from a job
Apply Color Tuner sets to a job
Move jobs around in all queues
Move jobs to the Active queue

About Splash Server

View Preferences

View Hot Folders

View Virtual Printers

View Secure Access settings
View Screening Preferences
View Print Info settings
View Color Profiles

View Calibration Summary
View Output Profiles

View Job Options for all jobs
View Schedule Job settings
View Mixed Media settings

Move jobs around in the Hold
and Error print queues

Edit Job Options
Delete Jobs
Schedule Jobs

Change/create Mixed Media
settings for jobs

Hold jobs

Remove a hold on jobs
Preflight jobs

Color Postflight jobs

Show Preflight for jobs

Restart processing a job
Resume processing a job

Apply defaults to a job

Clear Color Tuner from a job
Apply Color Tuner sets to a job
Move jobs around in all queues
Move jobs to the Active queue
About Splash Server

ColorCal
CopyCal
Spot Color Editor
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Administrator connections

An unlimited number of administrators can be connected to a EFI Splash RPX-iii through
Splash Server Remote 3.

Multiple administrators, both local and remote, can make changes to the same settings at the
same time.The last change made is the one that is applied.

User connections

An unlimited number of users can be connected through Splash Server Remote 3.

NoTe: When you have approximately 20 users on a 10 Mbit network, 40 users on a 100 Mbit,
or 50 users on a 1 Gbit network, server performance is impacted by 20 percent. We
recommend that you keep the number of connections low to avoid affecting EFI

Splash RPX-iii performance.

Users not logged on with EFI Splash RPX-iii Administrator privileges can view the main
server interface, job options, and preferences. If access is view-only, when a dialog box
appears, the OK button appears dimmed and a message informs users that they cannot save
changes until they log on with Administrator privileges, but access is limited to the lists on
page 114.
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Setting up

SCAN 116

The Scan feature enables the EFI Splash RPX-iii to operate as a high-resolution color scanner.
Scan allows you to scan printed images in CMYK, RGB, or Grayscale.

You can set up mailboxes on the EFI Splash RPX-iii and initiate scans at the digital press
Control Panel that you send to the mailboxes. You can then retrieve scans from the digital
press to the EFI Splash RPX-iii, and retrieve scans over the network to client Windows and
Mac OS computers, using the Splash Remote Scan application or the Splash Remote Scan
TWAIN plug-in module.

NOTE: Scan mailboxes can also be set up on the Fiery when the EFI Splash RPX-iii is
connected to the network. You can retrieve scans from any mailbox through the EFI
Splash RPX-iii or the Fiery, regardless of which system was used to originally create the
mailbox.

For information about installing the Splash Remote Scan application, see Getting Started.

mailboxes

A number of default scan mailboxes are set up on the Fiery. When the EFI Splash RPX-iii is
connected to the Fiery, a default SplashColorCal template is created on the Fiery for
calibration.

You can set up more scan mailboxes through the EFI Splash RPX-iii interface by creating
users. Those templates can be modified and deleted by deleting and modifying the user
account on the EFI Splash RPX-iii.

The default mailboxes on the Fiery are as follows:
¢ (color)

* (grayscale)

* (bw)

* (SplashColorCal)

The SplashColorCal mailbox is for EFI Splash RPX-iii calibration and should always be
used for EFI Splash RPX-iii calibration.

¢ (ColorCal)
The ColorCal mailbox is for the Fiery, and should not be used for EFI Splash RPX-iii

calibration.
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The following templates can be modified by the Administrator:

¢ COLOROGUEST
* BWOGUEST
* GRAYSCALEOGUEST

To set up custom mailboxes on the EFI Splash RPX-iii, use the following procedure.

To SET UP SCAN MAILBOXES

1 Choose Users from the Server menu.

1 “+" and “-” buttons
2 Scanning tab

Users

Username Scan Identity | Scanning
' T Y J

Name: | francesc

Password: |«

Verify: |«

1]
ey

2 In the Identity pane, click “+” to set up a new mailbox.

3 Type the required information in the Name and Password fields. Retype the Password in the
Verify field.

4 Click the Scanning tab.

Users
Username sean | | |dentity E—
EA"U\M scanning Scan Defaults
O Color Default Resolution: DPI
O Grayscale Reduce/Enlarge: | 100%

@ Black & White

Brightness _9_
O Phc'to 1 1 1 1 1 1

O Text Darker Lighter
® Photo & Text ot s

SAuln Exposure Lr‘mer : ‘ H\ghllr
Originals Format: Sharpness +
e s

[+[=]
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5 Select Allow scanning.

6 Select the required options and click OK.

NoTe: These settings become the default settings for this mailbox. You can temporarily
change the settings at the digital press for each scan. To change the defaults permanently, edit
them in the Scanning tab.

In the list of users, a checkmark is displayed in the Scan column for the mailbox you have
set up.

7 To change the name or password for a mailbox, select the mailbox name in the Identity pane,
and edit the information.

The maximum number of characters allowed in the Name field is 32. The maximum
numbers of characters allowed in the Password field is 32. You can add an unlimited number
of mailboxes to the Users list. However, if you try to enter a duplicate mailbox, a warning
dialog box appears, asking if you want to override an existing mailbox.

8 To remove a mailbox from the list, select the mailbox name and click “-".

Scanning from the digital press

Scan jobs can only be initiated at the digital press Control Panel. Scan jobs are sent to one of
the default Mailbox/Job Templates or custom Mailbox/Job Templates. Using Splash Remote
Scan, you can retrieve the scan jobs at the EFI Splash RPX-iii or over the network from client
Mac OS and Windows computers.

NoTE: You can print a scan job history report from the digital press.

To scan an image to a mailbox, use the following procedure.

TO SCAN AN IMAGE

1 On the digital press Control Panel touch screen, press All Services.
2 On the digital press Control Panel touch screen, press Network Scanning.

3 Select a mailbox/template that you want to use from the list in the Network Scanning pane.

NoTE: If you do not see a newly created mailbox in the list, press Update Templates on the
Control Panel.
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4 Specify the following scan settings on the Control Panel touch screen:
® Color scanning
® 2 Sided scanning
® Original type

5 Place the image that you want to scan on the digital press glass, or place it in the automatic
document feeder (ADF).

6 Press the green Start button on the Control Panel.

To scan multiple documents, repeat these steps for each scan. You can retrieve all of the
scanned images from the client workstation.

For more information about scanning features and settings, see the documentation that
accompanies your digital press.

Using Splash Remote Scan

With the Splash Remote Scan application and the TWAIN plug-in module, you can retrieve
scan files on the EFI Splash RPX-iii or remotely by accessing a mailbox. You can open the
scan file in Splash Remote Scan or in a host application, such as Photoshop, and save the file
to a location of your choice.

Configuring Splash Remote Scan

The first time you start Splash Remote Scan, you must configure the connection to the EFI
Splash RPX-iii. Before you configure the connection, you must have the correct IP address.
Make sure the EFI Splash RPX-iii is registered in a Domain Name Server (DNS) on your
network. When you open Splash Remote Scan, the Scan Configuration dialog box appears.
For instructions on configuring the connection to the EFI Splash RPX-iii for the first time,
see Gertting Started.

If you have previously configured a connection to the EFI Splash RPX-iii, it appears in the
main Splash Remote Scan window, and you can immediately start to retrieve any scans
initiated at the digital press control panel.

Retrieving a scan

After you scan a document at the digital press to a selected mailbox, you can retrieve the scan
from the EFI Splash RPX-iii or from a computer on the network.
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To RETRIEVE AND SEND A SCAN FILE

1

On the EFI Splash RPX-iii, click Scan in the toolbar or choose Scan from the File menu.

On a client computer, start the Splash Remote Scan application, or open the TWAIN compliant
application, such as Photoshop or Acrobat.

If you opened the TWAIN-compliant application, select Splash Remote Scan as the
import device.

Select the EFI Splash RPX-iii in the Configuration dialog box and click OK.
Type the name of the mailbox to which you scanned the file at the digital press.

Using guest as a mailbox name gets you access to the color, grayscale, black and white,

COLOROGUEST, BWOGUEST, and GRAYSCALEOGUEST templates on the digital press.
Click Refresh.

All scan jobs in the selected mailbox are displayed.

Select the scan that you want to save and click Send.

In the Send dialog box, select Save to Disk and browse to the location where you want to save
the file.

Choose PDF or JPEG from the File Format list.

NoTe: Choosing JPEG for multipage documents results in one file per page. Selecting PDF
generates a single document containing all pages.

Click Send to save the file.
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SPLASH PRINT KIOSK

About Splash Print Kiosk

The Splash Print Kiosk provides users with a convenient front-end for printing their
document files to the EFI Splash RPX-iii. This utility allows you to transport documents on
removable media, insert the media into the Macintosh computer running Splash Print Kiosk,
select documents to print, choose a minimal set of options, and then print the documents.

*  Splash Print Kiosk runs in the background. When no media is inserted, no user interface is
displayed, except for a menu bar. Administrators can click the application icon in the
Dock ito access Preferences.

*  When you insert removable media, a window appears, listing the files on the media. Each
supported document is shown with a check box, the document name, and a popup menu
for the print queue.

* You can check the documents that you want printed and can change the queue. Some
document types have additional print options.

*  When you click the Print button, Kiosk either sends the file directly to the EFI
Splash RPX-iii, or converts the file to PDE, and then sends it to the EFI Splash RPX-iii.
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Supported Document Types
Splash Print Kiosk supports the following document types:
*  Microsoft Office 2008 and Office 2004 (including Word, PowerPoint, and Excel)
¢ QuarkXPress 6.5 and 7.0
* Adobe InDesign CS 2.0
e PDE PostScript, EPS, TIFE and JPEG

Before you can print documents in these formats, the Microsoft Office, QuarkXPress, and
InDesign applications must be installed on the computer on which Splash Print Kiosk is
installed. Before attempting to print files in any of these formats, make sure that the required
software is installed and registered and able to run.

Specific Setup instructions are provided in the following sections.

Microsoft Office

If Project Gallery is displayed in Word, Excel, or PowerPoint, Splash Print Kiosk cannot send
Office documents for processing. You must disable the Project Gallery option.

To DISABLE THE PROJECT GALLERY OPTION

¢ In Excel and Word, go to Edit > Preferences > General.

¢ In PowerPoint, go to Edit > Preferences > View.

AdobeInDesign

Adobe InDesign requires that you do not show the Welcome screen.

TO HIDE THE ADOBE INDESIGN WELCOME SCREEN

e (lear the Show This Dialog at Startup option at the lower-left of the Welcome screen.
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Splash Print Kiosk Preferences

Splash Print Kiosk has a number of preferences that you can set.

To SET SPLASH PRINT KIOSK PREFERENCES

1 Select Preferences from the Splash Print Kiosk menu.

8anNnn Preferences

Settings

glnstall Fonts

gShow Unknown Documents
™ Check All Initially

EShow Print Options

Print Defaults

Queue " Hold |+J

Copies 1

PowerPaint | Handouts (3 slides per page) |+J

2 Disable or enable the options in the Settings pane:

* Install Fonts: When this option is selected, sends fonts to the Splash Server and installs
them on the Splash Server computer.

* Show Unknown Documents: When this option is selected, documents that cannot be
identified or do not correspond to supported applications are listed in the media window.

Unknown files, if displayed, are not checked for printing.

* Check All Initially: When this option is selected, all documents listed in the media window
are selected to be printed.

* Show Print Options: When this option is selected, the Print Options dialog box is opened
in the Splash Print Kiosk media window when you click Print. Allows you to override the
Preferences for a specific document.

3 In the Print Defaults pane, you can set the following:

* Default Queue: Allows you to select the queue on the Splash Server to which the Splash
Print Kiosk jobs are sent by default. Includes Virtual Printer queues.

* Copies: Sets number of copies of each document to print.

* PowerPoint: Determines how PowerPoint arranges slides on the page. Possible settings

include: Slides, Handouts (3 slides per page), Handouts (6 slides per page), and Notes.

4 Click OK (or Cancel) to exit the Preferences dialog box.
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Using Splash Print Kiosk

To use Splash Print Kiosk, you must insert your removable media into the computer on which

the Splash Print Kiosk is installed.

To SEND A JOB TO SPLASH PRINT K10SK

1

Start Splash Print Kiosk, and then insert the removable media containing your documents
into the Splash Server computer.

You can use CDs, DVDs, FireWire drives, or USB flash drives.

If the Splash Print Kiosk media window does not open, click the Splash Print Kiosk icon in
the Dock.

806 =
—Q Splash Print Kiosk =
= Printing to: 127.0.0.1 =
= =
— Disk: TESTFILES # show Print Options =
= Document Queue Application B
B T 100_2017JPC N
B O 52550000 Hold v Microsoft Excel =
| ¥ Picture L.tf Hold v None =
| @ JudoCampl.tif Hold v None =
- ¥ D26154 ID Parmigiano lkg*.indd  Hold + Adobe InDesign CS2

[ | @ JudoCamp2.tif Hold + None —]
| | & QUARKLTR.PS Hold ¥ None =
[ | ™ JudoCanmp3.tif Hold + None -
| # JClLogo.tif Hold + None —|
- # JClLogo2.tif Haold + None =
B O FK2006v1.xls Hold + Microsoft Excel -
N | Fukuda Kata 2006.xls Hold v Microsoft Excel |
| & SenseiDinner.tif Hold v None =
[ & Mark.tif Hold v None =|
[ # program2006.pdf Hold + None . =|
| @ ProgramCover2006.pdf Hold v None v |
—I= - - Kl
= [ Eee J [ print |
= 2

To select jobs for printing, select the check box to the left of the job. If you do not want to
print a job, clear the check box.

To select a queue for a specific job, click the queue name to display the queue menu.

To sort any of the columns by ascending or descending alphabetical order, click the column
heading.

If Show Print Options is selected, click Print to see the print options.

You can change the number of copies to print and the PowerPoint layout options.
Click Print to print the jobs.

Click Eject to allow you to remove the removable media from the computer.

The jobs you have sent to the Splash Server are displayed in the designated print queue.
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WEB QUEUE MANAGER

The Web Queue Manager installed with the EFI Splash RPX-iii Server Software allows
remote users on a TCP/IP network to view and control print jobs at the EFI Splash RPX-iii.

With Web Queue Manager, you can do the following:

* Review the status of print jobs sent to the EFI Splash RPX-iii.
* Hold print jobs.

* Release held print jobs.

* Review and change print options for a job in the print queue.

For information about configuring the EFI Splash RPX-iii to allow remote users to connect to
it, see the Configuration Guide.
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Using the Web Queue Manager

The following procedure describes how to manage jobs remotely using the Web Queue
Manager.

To USE THE WEB QUEUE MANAGER

1 Start your web browser application (Safari or Microsoft Internet Explorer).
2 In the Web browser, type the IP address for the EFI Splash RPX-iii.
Contact your administrator for the IP address.

The Web Queue Manager appears in the browser application window.

CusssERWANAGEMENT  awmewmees oo Lo

@ @ @

Select Joh Name Status User Submitied
~
Active il
a
£
Held
[ SplashREX50 Stastup Page pof Held Drop Folder 344PM A
[0 Troubleshootingpdf Held Diapped File L24PM

C

Error

Printer ot Responding, Please check that the Printer is on and that the ceble from the Controlleris
Status roperly connected.

A list of jobs waiting to print at the EFI Splash RPX-iii appears, along with information about
the printer and any errors that might have occurred at the printer.
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ssse

3 To view the Server preferences set for the EFI Splash RPX-iii, click the Server
Preferences icon.

1 Server Preferences icon ~

B Splash Server Management

@ € http://10.10.83.32/Splash/index.html “"C\v Google

2 Server Preferences

e .Mac Amazon eBay Yahoo! News(896)¥ Apple (101)v

(SPLASHSERVERMANGGEWENT  sewememess  eox  Luwlu
Job Name 5 Submitted Server
[Server Pages Network Color Jobs Log Profiles |
Active
Server Name
Splash Server
# Print Startup Page
] Always Hold Incoming Jobs
I Secure Erase
1 GA File Converter
- @ Strict
Printing =
Hold Constraints Lipsee
O BROCHURE.pdf Held  Dropped File ;;59
(O Never Timeout
Timeout
' Error Dialog L g
" 5 minutes
v () Beeps While Displayed
Printer Status Fuser web almost empty
Tray 1 Tray 2 Pages
|[Tabloid [ Leter LEF || 1Server Pages Network Color Jobs Log Profiles]
s
) Print Cover Page v
= =] Yal»

NoTe: If you log on with Administrator privileges, you can change the Server preferences from
this window.

4 To view information for a job, select the check box to the left of the job and click Job Info/
Edit at the bottom of the page, below the Error queue.

5 1If the job has already been RIPped, click Preview in the Job Information pane to view a
preview image of the first page of the job.

The EFI Splash RPX-iii must be configured to support the Preview feature.
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Managing jobs in the Print queue

If the EFI Splash RPX-iii is configured to allow you to manage print jobs in the Print queue,
you can use the Web Queue Manager to place jobs on hold, edit, print, or delete them.

To MANAGE PRINT JOBS FROM THE WEB QUEUE MANAGER

1 Click the Log On icon, enter your user name and password, and then click Register.

A confirmation message appears listing which jobs you have permission to manage on the
server with the Web Queue Manager.

NoTe: If you did not provide a user name and password when you originally sent the job to
the printer, enter the name that appears in the User column of the job list.

2 Select the job and use the command buttons that appear under the job list to manage jobs in
the Splash queues.

* Release causes a job to be processed and printed.
* Hold places a job on hold.
* Delete removes the job from the server.

* Job Info/Edit shows the current job information.
The job list updates to show the revised EFI Splash RPX-iii queue information.

Note: If the EFI Splash RPX-iii is configured to limit remote print queue management, the
Web Queue Manager displays a message that you can not access the selected job.

For more information, see the following procedure.

To EDIT THE PRINT OPTIONS FOR A JOB LISTED IN THE WEB QUEUE MANAGER

1 To view or change the print options for a job, select the check box to the left of the job, click
Job Info/Edit, and then click the Edit button that appears below the job information.

The current print options for the job appear.

Job Option links are located under each of the following tabs: Doc Info, Page, Tray Output,
Color, Quality, and Extras. For more information about these options, see the Printing Guide.

2 Select the desired print options and click Save Settings.
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Downloading installers and files from the Web Queue Manager

You can use the Web Queue Manager to download installers and other files from the EFI
Splash RPX-iii.

To DOWNLOAD INSTALLERS FROM THE EFI SPLASH RPX-iii

1 From the Web Queue Management screen, click the Downloads link.

A list of the EFI Splash RPX-iii downloadable files links is displayed.

CMYE Profiles
ColotTunerSets Folder
ColorSyneProfiles
Cutput Profiles

PhotoShop Separation Tables
E.GE Profiles

TIEF Folder
Zplash Documentation
Zplash Installer Deownloads

2 Click the Splash Installer Downloads link.

3 Select an installer to download.

NoTe: The installers are encoded appropriately for the platform on which they will be used. If
you are downloading the Mac OS installers to a Windows computer or vice-versa, make sure
your browser is set to not delete the encoded file. The decoding process can cause corruption
if run on the wrong platform.

NoTe: If you do not have other media available to restore your EFI Splash RPX-iii software,
download the installers to a server to retain a backup copy.

To download other files from the EFI Splash RPX-iii, click a link listed in the EFI
Splash RPX-iii downloadable files list.

Splash Installer Downloads
The Splash Installer Downloads available include the following:
* Splash Client application

* Splash Server Remote 3 application

Click the link for the application that you want to install and follow the on-screen

instructions.

For more information about installing EFI Splash RPX-iii software, see Getting Started.
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EFI SPLASH RPX-iii SERVER MENUS

This chapter provides detailed information about EFI Splash RPX-iii server menus.

Print queue

column headings

The EFI Splash RPX-iii provides column headings that can be added to any of the three print

queues to display information about jobs sent to the EFI Splash RPX-iii. For information

about modifying the print queue column headings, see page 20.

The column headings for the print queues are as follows:

Account displays the account from which the job came.

Application indicates the application in which the document was created or the type of
file, if the application is not known.

Comment displays any relevant comments on the job.

Completion Time indicates the last time the server completed a job activity.
Copies lists the number of copies requested.

Document lists the title of the job being sent to the EFI Splash RPX-iii.
Error Message explains why a job was sent to the Error queue.

Info-Basic displays a job status information symbol (see page 20).

Info-Detailed displays all job status information symbols that apply, with a colored
background that indicates job progress (see page 21).

Pages indicates the number of pages in the job.
Pages to Print shows the progress of the job.

Color Pages indicates the number of color pages in the job. Only available after the job has
been RIPped.

B&W Pages indicates the number of black only pages in the job. Only available after the job
has been RIPped.

Paper Size displays the paper size.

Size lists the full size of the RIPped job.

Spool Name assigns a spool number or file name to the job.
Spool Time indicates what time the job was spooled/received.

Status indicates whether the EFI Splash RPX-iii is receiving, printing, preflighting, or has

encountered a job error.

User displays the origin of the job.
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Main menus

The following table describes the top-level menus displayed on the EFI Splash RPX-iii server
computer when the EFI Splash RPX-iii server application is running. For more information,

see also page 25.

Menu Command Submenu command Description
Splash About Splash Server Displays information about the current version of EFI
Server Splash RPX-iii server application.

Preferences

Allows you to change the EFI Splash RPX-iii server
preferences settings. For more information, see the

Configuration Guide.

Controller Connection

Allows you to change which Fiery the Splash Server is
connected to. Processing must be stopped to change the

connection.

Check for Updates Checks for updates for Splash Server software.

Services The commands under this submenu provide access to
Mac OS X computer system services.

Hide Splash Server Minimizes and hides the EFI Splash RPX-iii server
application window. The application continues to run in
the background.

Hide Others Minimizes and hides all currently running applications
other than EFI Splash RPX-iii server application. The
hidden applications continue to run in the background.

Show All Maximizes and brings to the foreground all applications

that are currently running on the computer.

Quit Splash Server

Exits the EFI Splash RPX-iii server application.
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Menu Command Submenu command Description
File Open Allows you to browse for and import a file into the Hold
queue.

Save Spool File Save Spool File + Option key ~ Allows you to save a spooled file in the location of your
choice. The submenu command allows you to save the
spooled file along with any job settings for the job.

Close Window Closes the EFI Splash RPX-iii server application.

Show Job Log Opens the Job Log Viewer which allows you to view, short,
and print the Job Log.

Print Log Prints the current Job Log on a local printer.

Export Log Exports the contents of the current panel of the Jobs
window to tab-delimited text files on the Desktop.

Print Configuration Prints the current settings for the EFI Splash RPX-iii server

Page preferences. Only enabled with Administrator login.

Tray Alignment Allows the administrator to set print offsets for all jobs to
ensure centered output. Allows you to adjust placement of
the printed image on the page to correct for misalignments
of the paper tray.

Set Builder New Set Allows you to combine a series of jobs and print them as a
set.

Set Builder Open Set Accesses the list of created sets for editing purposes.

Color Tuner Sets Import Set Accesses functions of Color Tuner. For more information,
see the Color Guide.

Export Set
Delete Set
Scan Retrieve scans from digital press and save to disk.
Edit Not applicable to EFI Mac OS functions

Splash RPX-iii
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Menu Command Submenu command Description
Server Start/Stop Processing Sends the selected job to the Active queue and starts

processing it.

Hot Folders Allows you to create and modify Hot Folders.

Virtual Printers Allows you to create and set job options for Virtual Printers.

Secure Access Allows you to set Secure Access parameters.

Users Allows you to set up users.

Accounts Allows you to set up accounts.

Print Info Allows you to specify job information for the Control Strip.

Screening Preferences Allows you to set screening preferences.

ColorCal Opens the ColorCal application. For more information, see
the Color Guide.

Spot Color Editor Opens the Spot Color Editor. For more information, see the
Color Guide.

Login/Logout Opens the login/logout dialog for administrator access.

Profiles Color Profiles Allows you to assign the available color profiles and output
o Profil profiles on the EFI Splash RPX-iii. For more information,
utput frofiies see the Color Guide.

Import Color Profile Allows you to import color profiles to the EFI
Splash RPX-iii from other sources. For more information,
see the Color Guide.

Export Color Profile Allows you to export color profiles from the EFI
Splash RPX-iii to other locations. For more information, see
the Color Guide.

Delete Color Profiles Allows you to delete color profiles. For more information,

see the Color Guide.
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Menu Command Submenu command Description
Jobs Edit Job Opens the selected job in the Hold or Error queue.
Duplicate Job Duplicates the selected job.
Delete Job Deletes the job from the EFI Splash RPX-iii.

Delete Images

Deletes the image in the job from the EFI Splash RPX-iii.

Schedule Job Allows you to specify an exact date and time for printing
ajob.

Mixed Media Allows you to specify different media types for different
page ranges in the selected spooled/held job.

Hold Sends the job to the Hold queue.

Remove Hold Sends the job to the Active queue.

Process and Hold Processes the job to create ready-to-print rasters, but does
not print.

Preflight Runs a preflight check on the job.

Color Tweak Allows you to change color output without re-RIPping.

Color Postflight Runs a postflight check on the job and prints a
postflight report.

Postflight Report Creates a postflight report in PDF format and saves

automatically to the EFI Splash RPX-iii Macintosh.

Color Tuner

Opens the Color Tuner application. For more information,

see the Color Guide.

Show Preflight

Displays the Preflight report.

Restart Printing

Restarts printing a job from the beginning after it has
been stopped.

Resume Printing

Resumes printing from where an error on the EFI
Splash RPX-iii interrupted printing.

Apply Defaults Applies the default Job Settings to the job. For more
information, see the Printing Guide.

Edit Defaults Opens the Job Settings dialog box for editing settings.
For more information, see the Printing Guide.

Clear ColorTuner Clears all Color Tuner settings from selected job.
For more information, see the Color Guide.

Apply ColorTuner Set Allows you to select from list of saved Color Tuner sets.

For more information, see the Color Guide.
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Menu Command Submenu command Description
Window Minimize Minimizes the EFI Splash RPX-iii server application.
Zoom
Bring All to Front
Splash Server/ Shows or hides EFI Splash RPX-iii server application.

(name of server)
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Print queue Jobs menu

When you select a job in one of the print queues, you can access settings for the job.

Not all settings are available in both print queues.

To ACCESS JOB SETTINGS

Select the job and click the Jobs menu.

For a list of the available options accessed from the Jobs Menu, see page 134.

Select the job and click the arrow to the right of the print queue column headings.

The commands available in the print queue job menu are as follows:

NoTe: Keyboard shortcuts appear in parentheses.

Add Column adds an informational column to the Print Job Queues.

Select All Jobs selects all jobs in the queue. (Command + A)

Edit Job opens the Job Print Options menu for the selected job. (Command +E)
Duplicate Job duplicates the selected job.

Delete Job deletes the selected job. (Command + Delete)

Delete Images deletes the images from the selected job. (Command +Option+Delete)
Schedule Job allows you to schedule the time and day of printing.

Mixed Media allows you to specify different media for pages within a job.

Hold sends the job to the Hold queue. This option is only available if the job is in the
Active queue. (Command +H)

Remove Hold sends the job to the Active Queue. This option is only available if the job
is in the Hold or Error queue. (Command +R)

Process and Hold processes the job and sends it to the Hold queue.

Preflight screens job for errors and sends it to the Hold queue. (Command +F)
Color Postflight runs a Postflight check on a color job.

Postflight Report creates a report in PDF format of the Color Postflight check.

Color Tuner allows you to edit the color output of RIPped pages of a job, before it finishes
printing all copies of a job. (Command+T)

Color Tweak allows you to change the color output without re-RIPping.

Show Preflight opens the Preflight Results dialog box. This option is only available if the
job has been preflighted.
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* Restart Printing restarts printing after it has been stopped.

* Resume Printing resumes printing from where an error interrupted printing.
* Apply Defaults applies the current defaults that have been set at the server.

* Clear Color Tuner removes all color changes from a selected job.

* Apply ColorTuner Set applies all color changes from a selected job.
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Job Log information

The Job Log file automatically groups print jobs by user and contains the following

information about each job:

Item Description

User The network identity of the client that sent the job to the EFI
Splash RPX-iii.

Document The name of the file sent.

Date The date the job was sent.

Status If a job was completed, deleted, or held.

Start Time The time the EFI Splash RPX-iii started processing the job.

Print Time The total time (in seconds) required to print the job. Elapsed Time
starts with the time the job begins to be received at the server, and
ends at the time printing is completed.

RIP Time The amount of time (in seconds) that the EFI Splash RPX-iii spent

processing (RIPping) the job.

Color Model

If a job was printed in grayscale or color.

Duplex If the job was printed as double-sided output using the Manual
Duplex feature.

Paper Type The type of paper used for a job printed to the bypass tray.

Page Size The page size on which a job was printed.

Pages Rendered

The number of pages in the document.

Tray 5

If the job was printed from the bypass tray.

Color Images Printed

The total number of images printed in color. Each side of a duplex
sheet is counted, so 1 duplex page = 2 images printed.

Black Images Printed

The number of images printed using black ink only. Each side of a
duplex sheet is counted, so 1 duplex page = 2 images printed.

Cover Page

If a cover page was printed for a job.

Account Number

The account number associated with the file (if available).

Job Comment

Any information entered in the Document Comment field at the
printer driver.

For information about printing and exporting the Job Log, see page 50.
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